
 

 

User Manual
Version 2022.2[2328] 

P/N: #141339 



Copyright 2022, Eventide Inc
P/N: #141339 Version 2022.2[2328]
Every effort has been made to make this guide as complete and accurate as possible, but Eventide Inc. DISCLAIMS ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. The information provided is on an “as-is”
basis and is subject to change without notice or obligation. Eventide Inc. has neither liability nor responsibility to any person or
entity with respect to loss or damages arising from the information contained in this guide.
Notice: This computer program and its documentation are protected by copyright law and international treaties. Any
unauthorized copying or distribution of this program, its documentation, or any portion thereof may result in severe civil and
criminal penalties.
The software installed in accordance with this documentation is copyrighted and licensed by Eventide Inc. under separate
license agreement. The software may only be used pursuant to the terms and conditions of such license agreement. Any other
use may be a violation of law.

Eventide, NexLog, and MediaWorks are registered trademarks of Eventide Inc.

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson Licensing.

Supply of this product does not convey a license nor imply any right to distribute MPEG Layer-3 compliant content created
with this product in revenue-generating broadcast systems (terrestrial, satellite, cable and/or other distribution channels),
streaming applications (via Internet, intranets and/or other networks), other content distribution systems (pay-audio or audio-
on demand applications and the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard
drives, memory cards and the like). An independent license for such use is required. For details, please visit http://
mp3licensing.com.

All other trademarks contained herein are the property of their respective owners.

Eventide Inc.
One Alsan Way
Little Ferry, NJ 07643
201-641-1200

www.eventidecommunications.com



13

15

16

17

18

18

18

20

21

23

24

Table Of Contents

1. Using MediaWorks DX

1.1. Accessing MediaWorks DX

2. Locating and Organizing Recordings

2.1. Browsing for Recordings

2.2. Searching for Recordings

2.2.1. Creating a Search

2.2.2. Initiating a Search

2.3. Using Additional Filters

2.3.1. Standard Additional Filters

2.3.2. Custom Additional Filters

2.4. Saved Search Filters

2.5. Expanded Search Filter View

2.6. Tab Search



25

25

26

27

29

30

31

32

32

32

34

35

36

37

41

43

43

43

44

44

44

44

3. Viewing and Playing Recordings

3.1. Viewing Recordings

3.2. The Record View

3.3. Record View Menu Options

3.4. The Timeline View

3.4.1. Playback Settings Menu

3.4.2. Playback Settings Options

3.4.3. Resource Gain Defaults

3.4.4. EQ Settings

3.4.5. Timeline View Menu Options

3.4.6. Timeline Zoom Options

3.4.7. Full Timeline Mode

3.4.8. Headless View

3.5. Playing Audio Recordings

3.6. Playing Screen Recordings

3.7. The Playback Console

3.8. Playback Modes

3.8.1. Sequential Playback Mode

3.8.2. Mixed Playback Mode

3.8.3. Mixed Playback of a Single Resource/Channel

3.8.4. Mixed Playback of Currently Selected Call Records Only

3.8.5. Quick Playback from Timeline Header: Click to Play

3.9. Playback Audit



47

47

50

54

54

54

55

56

56

57

57

58

59

61

61

62

64

67

68

69

69

3.10. Word Factor Prime

3.10.1. Word Factor Prime Analytics

3.10.2. Word Factor Prime Transcribe

4. Creating an Incident

4.1. Adding and Removing Recordings from an Incident

4.2. Saving an Incident

4.3. Download an Incident Locally

4.3.1. Pack and Go

4.4. Incident Renaming

4.5. Incident Properties

4.5.1. Incident Properties and Notes: Description

4.5.2. Incident Properties and Notes: Notes

4.5.3. Incident Properties: Permissions

4.6. Redacting Recordings in an Incident

4.7. Incident Clip Management

4.7.1. Incident Clip Management Configuration and Permissions

4.7.2. Joining Calls with Incident Clip Management

4.7.3. Splitting Calls with Incident Clip Management

4.7.4. More about Incident Clip Management

4.8. Pinning Media to an Incident

4.9. Exporting an Incident

4.10. Deleting an Incident



71

71

72

73

73

75

76

77

81

85

87

90

90

90

93

94

96

5. Updating Recordings

5.1. Call Properties

5.1.1. Properties

5.1.2. All

5.1.3. History

5.1.4. Edit Call Properties

5.2. Editing Call Notes in the Call Grid

5.3. Annotating Calls

5.3.1. Audio Annotations

6. Exporting Recording Data from an Incident

6.1. The Export Dialog Box

6.2. Eventide AutoUnpacker

6.3. Export Presets and Defaults

6.4. Email Export

6.5. Export Single Recording

6.6. Screen Capture Export

7. Monitoring a Recorder

7.1. Channels Tab

7.2. Instant Recall Tab

7.2.1. Instant Recall Timeline



99

101

106

109

110

111

111

113

120

121

8. Geolocation Features

8.1. Geo-Display

8.2. Geo-Fence

8.3. Radio ID Display for Instant Recall

9. Resource Search Groups

9.1. Creating Resources Groups for Search

9.2. Adding Resources to Resource Groups

9.3. Deleting a Resource from a Resource Group

9.4. Using Resource Groups

10. NexLog Access Bridge

10.1. Connection Information

11. Archives

12. User Content Uploads

12.1. Uploading Content

12.1.1. Edit User Content



123

124

125

125

127

129

133

137

145

147

61

119

149

150

151

152

13. More about MediaWorks DX

13.1. Columns

13.2. Calltype

13.3. The Menu Bar

13.3.1. File Menu

13.3.2. Edit Menu

13.3.3. Tools Menu

13.3.4. Playback Menu

13.3.5. View Menu

13.3.6. Help Menu

13.4. Translations

14. Additional Optional Features

14.1. Incident Clip Management

14.2. User Content Uploads

14.3. Terms of Service Splash Screen

14.4. Media Access Blocking

14.5. Air Traffic Control / Air Traffic Management Mode

14.6. Interleaved Mode



155

156

157

159

160

15. MediaWorks DX Desktop

15.1. Installing MediaWorks DX Desktop

15.2. Using MediaWorks DX Desktop

15.3. Reading Local Incidents with MediaWorks DX Desktop

16. MediaAgent

16.1. Installing MediaAgent

16.2. Using MediaAgent



163

163

164

164

164

164

165

165

165

166

166

167

167

167

168

169

169

171

171

171

172

172

173

17. MediaWorks DX URL arguments

17.1. URL Arguments

17.1.1. Chrome Application

17.1.2. Debugging

17.1.3. Define Columns

17.1.4. Descriptor

17.1.5. Disable IR Filters

17.1.6. Disable Record Context Menu

17.1.7. ETI

17.1.8. Evaluation

17.1.9. Headless

17.1.10. Hide Transport

17.1.11. Incident

17.1.12. Instant Recall Minutes

17.1.13. Miniature Transport

17.1.14. Mobile Interface

17.1.15. Password

17.1.16. Session Type

17.1.17. Set Filter

17.1.18. Shortcut Keys

17.1.19. Show Map

17.1.20. Tab Type

17.1.21. Touch Mode

17.1.22. Username



177

178

178

179

180

183

183

18. Reporting Problems

A. Air Traffic Control/Management Mode

A.1. Setting Up ATC/ATM mode

A.2. Impounds

A.2.1. Creating an Impound

A.2.2. Creating an Impound From Search

A.2.3. Saving Impounds

A.3. Quarantines

A.3.1. Quarantine Storage Locations



This page was intentionally left 99.88% blank.



1. USING MEDIAWORKS DX

MediaWorks DX provides several ways to locate, organize, and replay recordings stored on an Eventide

NexLog DX-Series recorder. Once the desired recordings have been found, they can be easily organized

into incidents for saving and export. The recordings can also be examined, updated and listened to.

With MediaWorks DX you can also live monitor channel(s), view the status of channel(s), and (if

permitted) enable/disable recording on channel(s) for on-demand record/don’t record purposes. The

data for each recording can be exported in several ways.

The information about using MediaWorks DX includes:

Locating and Organizing Recordings

Viewing and Playing Recordings

Creating an Incident

Updating Recordings

Exporting Recording Data from an Incident

Monitoring a Recorder

Geolocation Features

Resource Search Groups

NexLog Access Bridge

Archives

1.1. Accessing MediaWorks DX

Open one of the supported browsers:

Google Chrome

Microsoft Edge (Chromium)

Mozilla Firefox

Enter the address of your NexLog DX-Series recorder in the URL bar. The address will either be an IP

address or a DNS address. Loading this page in the browser will bring you to a login page.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Fig. 1.1 MediaWorks DX Login/Splash Screen

For MediaWorks DX to connect to the recorder with HTTP, port 80 must be open; for HTTPS, ports

443. If you can’t connect, check with your network administrator that these ports are open.
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2. LOCATING AND ORGANIZING RECORDINGS

The typical process for finding and organizing recordings includes the following steps:

Browse or search for recording data on the recorder.

Create and save Incidents by selecting individual recordings or groups of recordings and

organizing them into incidents.

Export the data in a variety of formats.

2.1. Browsing for Recordings

The simplest method for locating recordings on the recorder is provided by the Browse tab, Fig. 2.1.

When viewing the Browse tab, the connected sources appear on the left. Below the source(s), a list of

months corresponding to the available data on the recorder will appear after you click on the + sign

next to the source. Clicking on a + sign next to a month will display all the days in that month that data

was recorded. Clicking on a + sign next to a day will open a list of channels on that recorder that contain

the data for the day selected. When you click on a channel, MediaWorks DX retrieves the recordings for

that channel and displays them in the upper right pane.

 

Fig. 2.1 Browse Tab

To retrieve recordings for a different day, expand the tree for the appropriate day and click on the

desired channel. The recordings for that channel will then be retrieved and displayed. To update the

browse tree, click on the blue refresh button at the top right of resources tree pane, next to the current

day. Each channel in the resources tree will be updated with the new calls.

• 

• 

• 
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The Browse tab can display the list of channel in three modes: Resource Name, Resource Name

Grouped by Recorder, or Channel Number Grouped by Recorder. The default is Resource Name. To

change the display mode, click on Show… at the top of the left pane and select the mode from the

drop-down menu. When viewing the information by Channel Number Grouped by Recorder, each

physical channel on the primary recorder and connected bridges and archives will be listed with its

channel number.

When viewing by Resource Name, each channel on the recorder and on all connected NexLog Access

Bridges will be listed by its resource name.

When using the Grouped by Recorder options, the resources will be divided into groups by which

NexLog system the resources originate from. In Resource Name mode, all resources made available by

NexLog Access Bridge connections will be listed alongside the locally available resources as if they were

all one system. Because physical Channel Number is tied specifically to hardware, it is only available in

Grouped by Recorder format.

2.2. Searching for Recordings

MediaWorks DX provides a powerful interface for advanced recording retrieval in the Search tab. When

viewing the Search tab, a list of search criteria in the form of Filters is provided in the left pane. Clicking

on Filters… at the top of the panel displays a drop-down list of filters.

 

Fig. 2.2 Search Tab

Each element of a search is contained within a search “panel” in the left pane of the Search tab. The 

Date and Resource panels are always required, so you must provide, at a minimum, a value for these

criteria to conduct a search for recordings. When more filters are added, additional panels will appear as

needed. If necessary, scroll the search panel to view the additional panels. Each filter panel can be

compressed or expanded by clicking on the arrow located in the upper left corner of the pane.
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2.2.1. Creating a Search

To create a search, first select one or more days from the Date filter area. Dates can be selected by

clicking on the calendar (default), or by specifying a date range or relative time period. To change the

way a date filter is specified, click the down arrow in the upper right corner of the Date filter panel and

choose the desired mode from the drop-down menu. The modes include Calendar (default), Date

Range, and Relative.

In the Calendar mode, you can select a continuous range of dates across more than one month, as

follows: Select the earliest date, click the forward arrow to navigate to the next month, hold down the

Shift key, and select the last date.

In Date Range mode, you can enter date and time by clicking the calendar icons next to the Start and

End text fields; this will pop open a window that lets you choose the date and time visually with sliders.

You can also edit the fields as text. The start and end fields use the Date Chooser format as set in the

Date Format Options.

In Relative mode, you can choose how far back from the current time you want the search to cover. For

example, a setting of 2 Days  and HH:MM:SS 04:15:30  will search on call records from the most

recent two days, four hours, fifteen minutes and thirty seconds relative to the time the Search button is

pressed. You can edit this as text or you can click the clock icon to bring up a window that has sliders to

set the hour, minute and second values.

Next, one or more resources or resource groups can be included in the search by selecting them in the

Resources filter panel below the Date panel. The Resources filter displays resources for the recorder.

Any number of resources can be selected. Resources can be selected by Resource Name, Physical

Channel Number Grouped by Recorder, or by Resource Name Grouped by Recorder. To change the

way the Resources filter is displayed, click the down arrow in the upper right corner of the Resources

filter panel and choose the desired mode from the drop-down menu.

When using the Grouped by Recorder options, the resources will be separated by NexLog system the

resources originate from. In Resource Name mode, all resources made available by NexLog Access

Bridge connections will be listed alongside the locally available resources as if it were all one system.

Because Physical Channel Number is tied specifically to hardware, it is only available in Grouped by

Recorder format.

2. LOCATING AND ORGANIZING RECORDINGS 17



2.2.2. Initiating a Search

To initiate a search, click on the Search button at the top right in the Search pane. All recordings that

meet the search criteria will be displayed in the tabular record view (in the right pane). You can also

press the enter key to kick off a search after changing any of the search parameters; otherwise the

enter key will start playback on the currently selected call.

2.3. Using Additional Filters

You may narrow your search by specifying additional filters, such as Call Length or Protected. To add an

additional Search filter, click on Filters… and select a filter from the list. The selected filter will be

displayed below the Resource filter area. More filters can be added, if necessary. Each new filter will

appear as an additional panel.

Note: Some additional filters are standard on all recorders and will always appear on the drop-down list.

Other additional filters depend on the custom fields included in the recording table. Some or none of

these filters may be included on the drop-down list of your recorder.

To remove a filter, click the X button which appears in the title bar of each optional filter. Alternately,

deselect the filter from the Filters… drop-down list. Once removed, the filter will not be used in

subsequent searches.

2.3.1. Standard Additional Filters

The following standard additional filters appear in the Filter drop-down list of all recorders.

Call Length

Enter the minimum and maximum call durations. MediaWorks DX will search for all recordings equal to or

between these values.

Call Note
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Enter text in the Note box. MediaWorks DX will perform a search for all recordings that contain this text

string in the Note field. Check the Case sensitive? box if you wish to make the search match case as well.

PIN

For installations that use a PIN code, enter the PIN number. MediaWorks DX will include this as part of the

search criteria.

Protected

Search for all recordings that are protected, or all recordings that are unprotected.

Telephone

Enter the telephone number digits. Check the Search DTMF box to find recordings which match the

telephone number in the DTMF field. Check the Search Caller ID box to find recordings which match the

telephone number in the Caller ID field.

Call Direction

This filter only applies to recordings that contain data in the Caller ID or DTMF fields. Enable Incoming to

find recordings that match incoming calls. Enable Outgoing to find recordings that match outgoing calls.

Enable Unknown to match recordings that could not be identified as either incoming or outgoing. Enable 

Use DTMF and Caller ID to determine to use heuristics on the data in the Caller ID and DTMF fields to

determine call direction.

Suppressed

Check Show suppressed to search for recordings that were suppressed on the recorder. Check Show

unsuppressed to search for recordings that were unsuppressed on the recorder. Check Show forced to

search for recordings that were forced into recording on the recorder.

Audited

Check Show accessed to search for recordings have had their data accessed by client applications. Check 

Show not accessed to search for recordings that have not had their data accessed by client applications.
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Deleted

Click on Show deleted to search for recordings that do not have audio data associated with them (as may

happen when the recorder purges data periodically to maintain free-space for newer calls. Click on Show

not deleted to search for recordings that do have audio data associated with them.

2.3.2. Custom Additional Filters

These additional filters are based on the custom fields that have been added to the call properties for a

particular recorder. Enter the string as it appears in the More tab of the Call Properties screen.

Following are some typical examples of additional custom filters which may or may not appear in the

Filter drop-down list of your recorder, depending on your particular custom fields.

:City:** Search for recordings that have a specific city name associated with

them. Enter the city name string the Search for: box.

:Customer Name:** Search for recordings that have a specific customer name associated with

them. Enter the customer name string in the Search for: box.

:Geo-Fence:** Search on a map for data occurring inside one or more geometric shapes.

This feature must be enabled on the recorder and location data must be provided. See additional

information in Geolocation Features.

Radioid

Search for radio call recordings that have Radioid information associated with them. Enter the Radioid

string in the Search for: box.

State

Search for recordings that have a specific state associated with them. Enter the state string in the Search

for: box.
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Street Address

Search for recordings that have a specific street address associated with them. Enter the street address

string in the Search for: box.

Subject

Search for recordings that have a specific subject associated with them. Enter the subject string in the 

Search for: box.

Talkgroup

Search for recordings that have a specific talk group associated with them. Enter the talk group string in the

Search for: box.

Time

Search for recordings that have a specific time associated with them. Enter the time string in the Search

for: box.

User Id

Search for recordings that have a specific user ID associated with them. Enter the user ID string in the 

Search for: box.

2.4. Saved Search Filters

If you regularly make use of the advanced Search Filter options, you will likely find Saved Search Filters

a very useful feature. This allows you to save and recall customizable search filters, including all

metadata fields and search criteria (date, resources) in the format and style you most prefer.

Saved Search filters can be accessed from the Filters button or the Tools menu option Edit Search

Filters. These options open a pop up window that allows you to load, save, and delete search filters.

Filters are saved based on the current state of the search column, and you can choose which values to

remember for the search, including Date, Resources, and any metadata options currently open.
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The Filter Name and lower section (by default called New Search Filter) show the Filter you are

currently acting on. Clicking a saved search will load the details into this window. If you want to then

load it into the search tab, click Load.

If you click one of the saved search filters and then want to work with the current settings instead, click

View Current to load the current settings into this window, from which they can be edited and saved.

For example, one may want to save a search that shows the last three days of call activity on a set of

channels, to load each Monday to see what happened over the weekend. To create a filter like that,

configure a search for Relative date mode, set it to 3 days, then select the resources desired, and then

open the Edit Search Filters and save as Last 3 Days.

 

Fig. 2.3 Last 3 Days Example

 Note

For convenience, if you save the hours, minutes and seconds as 0 and days as 3, this filter will load

as 3 days plus all the time that has passed today, so that the results show today and the previous 3

days in full. If you really want 72 hours only, save with the days set to 3 and the seconds set to 1.

Saved Search Filters work well with Geo-Location; you can save Geo-Fences of areas you regularly

search and recall them with ease.
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Fig. 2.4 Northern New Jersey Geo-Fence Saved Filter Example

2.5. Expanded Search Filter View

 

Fig. 2.5 Expanded Search

Expanded Search Filter View lets you fill your screen with all of the search filter options configured, for

a clear view of the search at a glance. For example, the above image shows a search for:

Calls recorded on March 29 or 30, 2020

on any of 16 specific resources

inside or near Wilmington, North Carolina

that have a note

and that have been accessed (played back)

Without expanding the view, a search like this would require scrolling up and down to be sure of what

parameters are set, even on a large monitor.

• 

• 

• 

• 

• 
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Use the > icon in the top left area next to “Filters” to expand the search. Use the same icon, now <, to

close it back to the original column width.

 

Fig. 2.6 Search, Filters, Expand

You can rearrange your filters as you wish, and then use the Lock icon to keep them in place. The

curved arrow will automatically organize them for you, if you wish. The X on the right edge can be used

to collapse the view back to the original column width.

 

Fig. 2.7 Lock, Autolayout, Close

2.6. Tab Search

Tab Search allows you to narrow your search results by searching all fields of all calls in a given search

result for any text string. For example, searching on “panel” could return calls that have 212 in DTMF,

Caller ID or a Street Address. It is a simple tool to find information quickly.

Once a search is performed, the calls will be listed only by the field that matched and the contents of

that field; clicking on a row in Tab Search will highlight that call in the call grid.

Tab Search is accessible from the View menu (Show Tab Search), and once shown, from the tool bar

above the call grid via the Magnifying Glass icon.
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3. VIEWING AND PLAYING RECORDINGS

After you have found and organized recordings you may view and play the recordings.

3.1. Viewing Recordings

Recordings displayed in the Browse, Search, or Incident tabs are shown in two different ways

simultaneously. The first is a simple tabular list displayed in the upper right-hand pane, called the record

view. This view can be customized in that it supports several different column and sorting options. The

second is a graphical chart of recordings displayed in the lower right-hand pane referred to as the

timeline. The timeline can also be customized, but only supports a single method of displaying the

recording data by time.

Together, the record view and timeline view provide a comprehensive look at the same set of data.

Selections between the two views are synchronized; any recordings selected in one are automatically

selected in the other. Similar operations may be performed from each view, including playback and

export.

3.2. The Record View

The record view in the upper right-hand pane presents recording data in tabular format. It is also called

the call grid. You may sort the information by clicking on the appropriate column heading. A small arrow

will indicate the sort direction. To reverse the sort, click the column heading again.

 

Fig. 3.1 Record View
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Columns can also be reorganized. Click and drag any column heading to a new position. The type and

number of columns can also be customized. Right click any column heading and a menu of available

column names will appear. You may add or delete a column from this menu. To reset the columns to

their user-defined default values, select the Reset to Default option.

 

Fig. 3.2 Record View Showing Records with Removed Media and an Error

There is a retention setting option that allows administrators to retain metadata (duration, date, custom
fields, channel number, etc) about record but delete the media (audio or screen recording) whenever the

recorder needs to delete recordings to make space. In this case, calls are shown with an [R] in the left-

most column of the call grid. A red “!” means there is an error with the call; hover the mouse over the !

to see the error message.

3.3. Record View Menu Options

Selecting a recording in the record view and then right-clicking on that recording causes the Record

View context menu to appear.

 

Fig. 3.3 Record View Context Menu
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The Record View context menu selections include:

Properties – See Section 5.1: Call Properties

Block Media Access… - See Section 14.4: Media Access Blocking (Optional, off by default)

Protect – Checking this box prevents the selected recording from being deleted from the recorder

due to recorder call retention policy. When protecting a large number of calls, a progress bar will

pop up to provide feedback while the system is protecting calls.

View Location - View recording’s location on a map if available. See Section 8: Geolocation

Features

New Incident from Selected Records – See Section 4: Creating an Incident

Add Selected to incident – See Section 4.1: Adding and Removing Recordings from an Incident

Evaluate Records – Evaluate selected call recordings. Requires Quality Factor add-on license. See

Eventide Quality Factor Software Manual for details.

Start Sequential Playback – See Section 3.8.1: Sequential Playback Mode

Export… – See Section 6: Exporting Recording Data from an Incident

Export Single Recording – See Section 6: Exporting Recording Data from an Incident

Export Using Preset – Exports selected recordings using a saved preset. See Section 6.3: Export

Presets and Defaults

Add Text Annotation – Add annotations to a call, at a specific point in time. See Section 5.3:

Annotating Calls

Add Audio Annotation – Add audio commentary to a call, at a specific point in time. See Section

5.3: Annotating Calls

Upload User Content - Upload a file to the recorder for recording keeping and use in incidents.

See Section 12: User Content Uploads

Show Errors… – This option will only appear if there is an error with the record, indicated by a red

exclamation point next to the call. Select it to get see information about the error.

Generate Word Factor – Enables Speech to Text Integration automatically, or on select playback.

See Section 3.10: Word Factor Prime

3.4. The Timeline View

The Timeline view in the lower right-hand pane shows the same set of recordings that are displayed in

the Record view, but presents the recording data in a linear chart. Recordings are organized into groups

by channel name and are displayed in chronological order from left to right. The individual recordings

are drawn in the timeline in the horizontal direction in relation to their duration. Scroll the timeline to

the right (or to the left) to view recordings that are not visible. If more than one channel is represented

in the data, scroll the timeline up or down to display channels that may not be initially visible.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Fig. 3.4 Timeline View - Audio Recordings

You can increase or decrease the time length displayed on the timeline, and increase or decrease the

height of the individual rows. To zoom, click on the appropriate small magnifying glass in the lower left

corner of the pane. (These are from left to right: vertical zoom in, vertical zoom out, horizontal zoom in,

horizontal zoom out.) In Fig. 3.4, it has the words Thirty Seconds in the left corner. Clicking this will

open a menu offering a variety of time scales from one second to one year. The selected time scale

defines the amount of time to be displayed between each “tick” on the timeline. In Fig. 3.4, there are

three ticks, each representing the start of each half minute.

 Note

If you zoom out on a large amount of call data with several system or text annotations per call,

annotations will be displayed as red dots to improve legibility. You will need to zoom in to see

details for a specific call.

 

Fig. 3.5 Example of Annotations as Red Dots at High Zoom
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 Note

If an Analog board’s channel is configured in the Configuration Manager to record with the detect

type On Voxbreak, you can have recordings which are assigned the calltype Inactivity in

MediaWorks DX. They also have a different appearance from regular Audio recordings in the

timeline. As shown in Fig. 3.6 below, the timeline contains the standard grey blocks which

correspond to Audio recordings as well as transparent blocks which correspond to Inactivity

recordings. These Inactivity recordings occur when the audio input levels on the channel fall below

the channel’s configured VOX threshold. The difference in appearance makes it easy to distinguish

between Inactivity and Audio recordings in the timeline, while the difference in calltype

designation makes it easy to search for periods of activity or inactivity. Inactivity recordings can be

played from the timeline or the record view table by double-clicking it just as any other call can.

For more details regarding “ON VOXBREAK”, refer to the Eventide NexLog DX-Series User Manual.

 

Fig. 3.6 Example of Inactive and Audio Calls from On Voxbreak Recordings

3.4.1. Playback Settings Menu

In the Channel Name box on the left there are a number of playback settings that you can set on a

channel-by-channel basis by using the settings menu.
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Fig. 3.7 Playback Settings Menu

They include:

Volume Slider - Moving the volume slider left or right decreases or increases the volume for this

channel. Clicking on the mute button (green speaker icon) to the left of the down arrow mutes the

sound on the selected channel. The button will then be grayed out. Clicking on the grayed-out

mute button will restore the sound to that channel.

Balance Slider - Pan this channel to the right, center or left of the stereo field.

AGC – Checking this box will enable automatic gain control on this channel.

EQ Boost - Apply an EQ boost or cut based on the EQ settings in the tool menu.

Options… - Clicking on this menu item displays an Options dialog box. (See Playback Settings

Options below.)

3.4.2. Playback Settings Options

The Options dialog box for playback settings allows you to enable Mute, AGC, Obfuscate or EQ Boost

for this channel. Mute, AGC and EQ Boost just have an Enable checkbox to turn the feature on and off.

The obfuscate option allows you to garble the sound of voices on the channel so that the identity of the

speaker is obscured. The Amount slider allows you to adjust the amount the effect is applied to the

audio.

• 

• 

• 

• 

• 
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Fig. 3.8 Obfuscate Option

3.4.3. Resource Gain Defaults

In the Tools menu, you will find Resource Gain Defaults, which opens to the above panel that allows you

to configure a default setting for the EQ, AGC and Gain for every resource name currently on the

system, so that every tab you open from then on will load these settings.

 

Fig. 3.9 Resource Gain Defaults

Reset will return to factory defaults: EQ and AGC Off, Volume at 0db gain. Use Current will change the

settings to those set in the currently open tab; this is useful if you’ve gotten it “just right” and want to
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save the settings for the future. Apply to Tab will apply all of the settings in this pop up to the open tab.

Save will save the settings and they will be applied when new tabs are opened.

3.4.4. EQ Settings

In the Tools menu, the EQ Settings menu option opens a pop up that allows you to set the amount of

signal boost or cut in a three band EQ. This allows you to tune the playback of call audio to improve

sound quality and compensate for lines that are too bright or muddy. One EQ setting is supported at a

time; you can either have it turned on for all channels here with Always On setting, or you can turn it on

for specific channels only as detailed above.

 

Fig. 3.10 EQ Settings

3.4.5. Timeline View Menu Options

Selecting a recording in the Timeline view and then right-clicking on that recording causes the Timeline

View menu to appear.

The menu selections are the same as those in the Record View menu. Refer to the Record View Menu

Options for information about those menu items.

Note: When working in an Incident Tab, there is also a Remove option that can be selected; selecting 

Remove From Incident allows you to remove the selected recording(s) from the incident.

3.4.6. Timeline Zoom Options

The Timeline has zoom options that let you adjust how much call data you are looking at in a given

amount of horizontal space. This ranges in granularity from one second to one year.
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Fig. 3.11 Timeline Zoom Options

The Timeline has zoom options that let you adjust how much call data you are looking at in a given

amount of horizontal or vertical space. The horizontal ranges in granularity from one second to one

year. This grain affects what the distance between two markers on the timeline means. In the example

below, the zoom is set to one minute and the dark checkmarks in the timeline are one minute apart:

 

Fig. 3.12 Timeline At One Minute Zoom
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The magnifying glasses with + and – signs can be used to increase or decrease the horizontal (time)

zoom level; the arrows change the vertical zoom. Shift+Click into the timeline will zoom in, Shift+Right-

Click will zoom out.

3.4.7. Full Timeline Mode

When using the “Search” Tab, MediaWorks DX will now expand the Timeline view horizontally to offer a

larger Timeline window.

By double clicking the divider between the calendar pane and the callgrid pane, MediaWorks DX

will toggle between Standard View and Full Timeline Mode.

 

Fig. 3.13 Standard View

• 
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Fig. 3.14 Full Timeline Mode

3.4.8. Headless View

When configuring User Settings in NexLog DX-Series, selecting the “Instant Recall” permission allows

for a large format view of the most recent calls on the recorder.
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Fig. 3.15 Headless View

3.5. Playing Audio Recordings

Once you have located recordings from the Browse, Search, or Incident tabs, you have several options

for playing the recordings. The following information describes the options for playing recordings in the 

Sequential mode. In this mode, recordings are played one recording at a time, in the order in which they

appear in the record list. To change the play order, sort the list of recordings differently. Playback will

adapt to the new sequence. For information about playing recordings in the Mixed mode, see Playback

Modes.

To begin playing the audio from a recording, press the Play button in the Playback console at the

bottom of the screen (see The Playback Console). The first recording in the list will begin playing. To

indicate which recording is currently playing a green arrow appears to the left of the recording in the

Recording pane, and the call’s row is highlighted in green.

Alternatively, select a recording and press Enter on the keyboard to begin playback, or press the 

Spacebar on the keyboard to begin, pause, and resume playback. Once the first recording in the list has

been selected, the Spacebar can only be used to pause and resume play. To select another recording,

highlight the recording in the Record view or in the Timeline view and press the Enter key or double-

click on the new recording. The recording will start playing immediately. Use the Spacebar or Pause

button to stop playback and the Spacebar or Play button to resume playback.
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You may also use the sub-menu items in the Playback menu to control playback or right-click the

desired recording and select Start Sequential Playback from the drop-down menu.

3.6. Playing Screen Recordings

 

Fig. 3.16 Screen Playback

Screen recordings can be played back in the same way as Audio calls, but there are additional options

that relate specifically to screens. These options are configured via the Multimedia Display Options

window you can access via the View menu:
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Fig. 3.17 Multimedia Display Options

This allows you configure how multimedia recordings will be played back, and also allows for

configuring the real-time display of Metadata, discussed below. Display in Application is shown above;

the screen recording plays back in a floating window inside the MediaWorks DX browser window.

Display in Canvas looks like this:
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Fig. 3.18 Canvas at Top

A panel appears above or to the right of the search results (depending on the Multimedia Orientation

setting). This panel is called the Multimedia Canvas. It can also appear to the right of the call list:

 

Fig. 3.19 Canvas at Right
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Fig. 3.20 Media Window Controls (Detail)

The top right corner of the media window contains these three buttons: Pop out to Application, Pop

Out to External Window, and Close. If popped out to the application level, the first button will show a

minus sign for “Collapse into Multimedia Canvas.”

 

Fig. 3.21 Media Window Popped Out

When popped out to an external window, the multimedia record is still controlled by the Playback

Console in the main MediaWorks DX window. It also just has an X for Close in the upper right corner,

which will pop the call back into the main window.
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Fig. 3.22 Real-Time Metadata Panel

The Metadata Panel shows a list in chronological order of the metadata associated with calls played

back from this search, browse or incident. The line in bold is the current or most recently played call.

This lets you highlight the specific metadata you want to keep track of as you play calls.

3.7. The Playback Console

The Playback Console, located at the bottom of the browser window, allows you to control all aspects

of playing recordings. From the Playback Console, you can adjust the volume and speed of the

recording(s) being played:

Volume – Use this slider to increase or decrease the master audio volume. Moving the slider to

the right increases the volume; moving it to the left decreases the volume. Pressing the 100%

button to the right of the slider will reset the slider to the default center position.

Speed – Use this slider to increase or decrease the playing speed of the recording(s). Moving the

slider to the right increases the speed; moving it to the left decreases the speed. Pressing the

100% button to the right of the slider will reset the slider to the default position.

 

Fig. 3.23 Playback Console

The buttons in the center of the console include (from left to right):

Previous Recording – If playback is less than 3 seconds into the recording, moves to previous

recording in the selected sequence. If playback is more than 3 seconds into the recording, resets

to the start of the current recording.

Play/Pause – Plays any highlighted recording, pauses if currently playing, or resumes playback

after pausing.

• 

• 

• 

• 
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Next Recording – Moves to the next recording in the selected sequence.

Loop – Loops playback for the selected recording or recordings. For sequential playback, this is

the beginning and end of a recording or the loop boundary settings within a single recording. For

mixed playback this is the loop boundary settings anywhere within the timeline.

To the top of the console are the following additional tools:

Slider – The slider on top of the console allows you to change the playback position. This is

known as scrubbing. You can scrub at any time during playback. To quickly move to a different

spot within a recording, click and drag the scrub slider. While scrubbing, keep track of the position

by watching the playback time indicator.

Skip - The double-arrow buttons on each side of the slider allow you to Skip Forward (>>) or Skip

Back (<<).

While a recording is being played, its attributes scroll from right to left in the area above the playback

controls. This information includes the recording’s channel name, recording time and length of the

recording. The information in the area above the slider includes the current playback time. If you click

inside this area, it will switch to show the total length of the recording (on the right) as well as current

playback position (on the left).

The Playback Console can be displayed in two modes: Static Playback Console (at the bottom of the

page) and Floating Playback Console . The mode can be switched at any time from static to float by

clicking arrow button in the upper right corner of the Static Playback Console. Once enabled, the

Floating Playback Console will be displayed in the upper right corner of the tab by default, but it can be

moved around the window. To change the mode back to static, click x close button in the upper right

corner of the float console.

 

Fig. 3.24 Floating Playback Console

• 

• 

• 

• 
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The Playback Console state is global for all tabs, except Channels tab and Evaluations tab and saved

between the loads. The Static Playback Console is located at the bottom of the browser window. Once

started in one tab, the playback can be controlled with the same console in other tabs. Playback

Console is displayed as blue in active tab, where the calls are playing from and grey – in other tabs.

Anytime the Playback Console mode can be switched from static to float by clicking arrow button in

the upper right corner of the Static Playback Console. Once enabled, Float Playback Console will be

displayed in the upper right corner of the tab by default, but it can be moved around the window. To

disable Float Playback Console, click x close button in the upper right corner of the float console.

3.8. Playback Modes

MediaWorks DX supports two modes of playback: sequential and mixed. Recording data can be

streamed from an Eventide recorder or from a remote incident containing embedded audio data.

Optionally, playback can be modified to include “Time Marker” information at the start of each

recording.

3.8.1. Sequential Playback Mode

Sequential playback occurs on one recording at a time. The order in which recordings play is determined

by the record view. To change the order in which sequential playback operates, change the sort order of

the record view.

To begin sequential playback, select Start Sequential Playback from the right-click context menu in the

Record view or Timeline view. Alternatively, you can double-click a recording or highlight a recording

and press the Enter key.

3.8.2. Mixed Playback Mode

Mixed playback will play back recordings in the timing that they actually occurred. Mixed Mode

playback is also referred to as ‘real time playback’. The order in which recordings plays is determined by

the start time of the recording. Mixed playback always proceeds in time order, from earliest to latest. If

you are examining recordings from multiple channels, the case may be that multiple recordings occur at

the same or overlapping times.

For example, if audio was recorded on a channel named “Dispatch 1” at the same time audio was

recorded on a channel named “Emergency 5”, the audio for both recordings will be played back at the

3. VIEWING AND PLAYING RECORDINGS 43



same time. When audio is playing in Mixed mode, you can easily follow the progress in the timeline,

which highlights all playing recordings across all channels.

3.8.3. Mixed Playback of a Single Resource/Channel

Single timeline resource/channel can be played back in mixed mode. This is useful for playing back a

single talkgroup or resource while looking at search results or instant recall on more than one timeline

resource at a time. In order to active Single Resource mixed playback hold down the Ctrl key while

viewing the properties menu and select “Select Resource Mixed Playback.”

3.8.4. Mixed Playback of Currently Selected Call Records Only

You can playback only a selected subset of calls in the timeline, in mixed mode. Use Ctrl+click to

select multiple calls from the timeline or the call list, and then right click one of the selected calls and

choose “Start Mixed Playback.” This will then play in real time all of the selected calls and no other calls.

3.8.5. Quick Playback from Timeline Header: Click to Play

You can click in the timeline header (where the time is displayed along the top) to start mixed playback

at any point. We call this “click to play.” If you have started calls in sequential mode, a click to play will

follow suit and play in sequential mode. You can switch it back to Mixed by right-clicking in the Timeline

header and selecting “Start Mixed Playback.”

3.9. Playback Audit

MediaWorks DX now offers a played audio indicator to let users see previously played recordings.

Under the “View” dropdown in the menu bar, select “Show Playback Audit”
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Fig. 3.25 Show Playback Audit

With this function enabled, the user now has a visible indication of any recordings that have been

previously listened to.
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Fig. 3.26 Playback Audit

Grey Dot shows any records listened to in a past session

 

Fig. 3.27 Past Session Indicator

Orange Dot shows recordings listened to in current active session

 

Fig. 3.28 Current Session Indicator

• 

• 
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3.10. Word Factor Prime

MediaWorks DX now features Eventide’s improved Speech-to-Text functionality. With Word Factor

Prime, users can transcribe speicified channels either in real-time (Word Factor Prime Analytics) or

selected recordings (Word Factor Prime Transcribe) to provide quick and accurate dictation on calls and

events.

 Note

Word Factor Prime Analytics and Word Factor Prime Transcribe are seperately licensed Add-Ons

and can not be used simultaneously.

3.10.1. Word Factor Prime Analytics

To automatically apply Word Factor Prime Analytics to recordings in real time, you’ll need to first enable

the option and configure Channels and Call Pointer in the Eventide NexLog DX-Series Recording - Data

Integrations section
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Fig. 3.29 Word Factor Enable/Configure

Channels Specifies which channel[s] will automatically enable Word Factor Prime Speech-to-Text

Call Pointer Speficies The date and time at which Word Factor Prime will start transcribing

Speech-to-Text

Once Word Factor Prime Analytics has been configured, MediaWorks DX will now automatically

process Speech-to-Text on all enabled Channels, visible on the recording in the timeline (hover over any

of the grey bar on the recording) as well as within the recording’s call properties.

• 

• 

48 3. VIEWING AND PLAYING RECORDINGS



 

Fig. 3.30 Word Factor Prime hover-over
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Fig. 3.31 Word Factor Prime Properties View

3.10.2. Word Factor Prime Transcribe

When using Word Factor Prime Transcribe, Speech-to-text can be requested on any channel or

recording by simply enabling in the NexLog DX-Series Recording - Data Integrations section, then

logging into your MediaWorks DX system and right-clicking a recording and selecting “Generate Word

Factor”.
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Fig. 3.32 Generate Word Factor

Speech-to-Text will now be visible on recording view (hover over on grey section) as well as within

recording call properties.
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4. CREATING AN INCIDENT

In MediaWorks DX, an incident contains a group of related recordings. To find recordings, see Browsing

for Recordings and Searching for Recordings. Once a set of recordings has been found, the next step is

to group them into related sets known as “incidents.” New incidents can be created from a selection of

recordings, and additional recordings can be appended to existing incidents. Incidents form the

foundation for many of the other MediaWorks DX functions, such as exporting recording data.

Incidents can also be shared with other users by emailing them or saving them to a shared location on

the Eventide recorder.

Incidents can be stored remotely on the recorder. To create a new incident, select New Tab from the 

File menu and then select Incident from the drop-down list. An empty Incident tab labeled “Untitled”

will be created. To create a new incident with an initial set of recordings, first select the recordings from

the Record view or Timeline view. Then right-click and select New Incident from Selected Records from

the drop-down menu. A new incident tab labeled “Untitled” will be created containing the recordings

you selected.

 

Fig. 4.1 Incident

An incident can also be populated with recordings in several other ways. From the Browse or Search

tab, a group of recordings can be copied to an incident tab using drag-and-drop. With the Browse or

Search tab open, select one or more recordings. Then click the selected recordings and, while holding

the mouse button down, drag the recordings to the new Incident tab. Release the mouse over the

Incident tab and the recordings will be added to that incident.
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4.1. Adding and Removing Recordings from an Incident

Once created, an incident can be further expanded or reduced. To add recordings to an open incident,
first select the desired recordings from the Browse or Search tabs, or another Incident tab. Once

selected, click and drag the selection to the destination Incident tab and then release it. The recordings

will be appended to that incident.

Alternatively, after having selected the recordings you wish to add, right-click the selection and choose 

Add to incident from the menu that appears. A submenu lists all possible destination incidents. Select

the desired incident and the recordings will be appended to it.

To remove recordings from an incident, select the recordings you wish to remove from the Incident tab

they are associated with and select Remove from the Edit menu. Alternatively, you can right-click the

recording selection and choose Remove from the menu that appears.

4.2. Saving an Incident

To save an incident to the recorder, first make sure the Incident tab is selected, then select Save

Incident from the File menu. If this is a new incident, when the Save Incident dialog box appears, the

Recorder tab will be automatically selected.

The Protect Calls in Incident option will automatically mark all recordings as protected when saving the

incident; this is turned on by default. Optionally you can edit the incident properties and permissions

here too. When saving an incident with a large number of calls with this option on, a progress bar will

pop up to provide feedback while the system is protecting calls.

Enter an Incident Name and then click OK to save.

4.3. Download an Incident Locally

Incidents can be also be saved locally to your computer. By default, one usually wants to save an

incident remotely, which means on the recorder itself, for use on that recorder. But if you need to share

an incident across different recorders, you can save the incident locally to your computer as an

<incident name>.eti file. This file can then be shared and opened with the Open Incident file menu

option.
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To save locally, you must first save the incident to the recorder. Once you have saved it to the recorder,

select Save Incident As from the File menu, and choose the Download tab. You can optionally enter a

password here that the incident will require to open.

 

Fig. 4.2 Local Incident Save

This file can then be shared and opened with the Open Incident file menu option, by clicking the local

tab and clicking Add File. Select an .eti file, click ok and then click OK in the Open Incident dialog. If

there is a password, you will be prompted to enter it and if that succeeds, the incident will open with all

of the calls, notes, attachments and metadata as seen on the original recorder.

4.3.1. Pack and Go

 License Required

This feature must be licensed to be used. Contact your Eventide Dealer for assistance.

When licensed, Pack and Go allows you to export an offline incident with a built in player. This is useful

for allowing a user to explore an incident’s content without access to a recorder.

The Pack and Go player is portable and does not need to be installed. It does not require any network

access and can be opened by anyone with a Microsoft Windows 7 or newer PC. The player can

optionally require a password.
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4.4. Incident Renaming

Incidents can be renamed by right-clicking on the incident either in the open incident menu or on the

tab of an open incident.

 

Fig. 4.3 Rename Option in Tab Right-Click Menu

 

Fig. 4.4 Incident Rename Pop Up

4.5. Incident Properties

The Properties button (at the top of the tab and in the Save window) opens to an Incident Properties

window that allows for a searchable text description of the incident, as well as fine control of which

permissions each user on the system has for this incident.
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Fig. 4.5 Incident Properties and Notes

This window contains a variety of information and options for this incident, including Permissions,

Description, Notes, File Attachments, and an Incident Link URL.

The “Protect Calls on Save” checkbox in the upper right corner controls whether or not calls added to

this incident after the initial save will be protected when the incident is saved.

4.5.1. Incident Properties and Notes: Description

The Description text box at the top of the Incident Properties window can be used to describe the

incident and highlight anything particularly interesting about it. This description can then be searched

for in Open Incident dialog, making it easier to find specific incidents on systems that have many.

4.5.2. Incident Properties and Notes: Notes

Notes can be added by anyone with read/write permissions for the incident. Each note will include the

creator, the date created, and if media is attached to the note, a file name. Short notes will be fully

visible but for longer notes, you can right-click and select View Note from the context menu to see the

full text of the note. If there is a document attached of a supported type (text, jpg, wav, mp3, etc), you
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will be able to see it in this pop up as well. From this context menu you can also choose to edit or delete

the note or download the attached file. The paper clip icon next to Add allows you to attach media (or

any kind of file) to the note.

 

Fig. 4.6 Incident View Note

4.5.3. Incident Properties: Permissions

The Properties button (at the top of the tab and in the Save window) opens to an Incident Properties

window that allows for a searchable text description of the incident, as well as fine control of which

permissions each user on the system has for this incident.
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Fig. 4.7 Incident Properties - Permissions

The default for new incidents is Read Only: only the original creator of the incident can make changes,

and everyone else can open it to listen to calls and read notes.

The radio buttons in the top line allow you to assign permissions for all users at once, and can also be

used first to set a default state before assigning specific permissions to a few users. For example, you

may want only two users to have access to this incident, so you click the All Users Owner Only button

and then click Read Only for the two users you want to share it with. Owner Only is the same as No

Access for users other than the user that created this incident.

Note that the Owner of an incident always has Read/Write permissions.

4.6. Redacting Recordings in an Incident

Redaction is an umbrella feature allowing for modifying part of a call’s audio, either by replacing it with

silence or a tone, or by applying an effect such as obfuscation or automatic gain correction. Obfuscation

transforms the original speaker’s voice into something clear but not recognizable as a specific person

and aims to make identifying a source difficult.
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Fig. 4.8 Redaction in Context Menu

Redaction points are available only for calls organized into an incident. Right-click on a call record to

add a Redaction point. This will show up as a purple highlighted space in the call, with a smaller square

in the upper right corner. Clicking that square gives the redaction space focus, so you can adjust its

duration by dragging the start and end times, or adjust its location by click in the center and dragging it

from side to side.

 

Fig. 4.9 Redaction Area

If you right-click the Redaction area, a Redaction specific menu will pop up. From here, you can open an

options menu for this redaction, change the kind of effect to be applied (Mute, Tone, AGC, or
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Obfuscate), “Move” the redaction by giving it mouse-focus the way clicking the upper right corner

would, or remove the redaction entirely.

 

Fig. 4.10 Redaction Area

The Options for a Redaction include the maximum gain of the AGC, or the kind of Obfuscation. A lower

value for Obfuscation modulates pitch downward, and a higher one moves it upwards.

4.7. Incident Clip Management

Incident Clip Management is a feature intended for systems that use analog recording with imperfect

call stop and start recording criteria. On systems relying on Vox or TRV thresholds and hold times,

sometimes a single call will be recorded as two, and other times two calls can be recorded in a single

call.

Incident Clip Management allows users making incidents to join or split audio calls in an incident so that

the calls are played back correctly. The original call records remain on the recorder in their as-recorded

state.

A split or joined call record is called a clip.

4.7.1. Incident Clip Management Configuration and Permissions

Incident Clip Management is an optional feature: for anyone on the system to use it an Admin user

must turn the feature on in Configuration Manager under Users and Security: System Security. When

enabled, this will add two custom fields required for Incident Clip Management, is_clipped_media and

clip_details, if they do not already exist. At that point, any Admin or Researcher user can use Incident

Clip Management.
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Fig. 4.11 Enable Incident Clip Management in Configuration Manager

4.7.2. Joining Calls with Incident Clip Management

Once configured, the tools to split and join media are relatively straight forward. Note that this function

is only available for use on call records in an incident. Below is an example image showing a call that

split because the volume of the audio dropped too low for too long, causing it to be broken into two

calls.

 

Fig. 4.12 Enable Incident Clip Management in Configuration Manager

In order to fix this:

Add both calls to an incident and select one of the calls, right-click and select “Split/Join Media”

from the context menu.

1. 
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Fig. 4.13 Select Split/Join Media from Menu

The Split/Join Area will appear; this is very similar to the Redaction tools previously discussed.

 

Fig. 4.14 Split/Join Area

Drag the edges of the Split/Join Area to contain the call audio.

Fig. 4.15 Resize Split/Join Area to Include All Audio

And then click the green check box to merge, or the red X to cancel.

1. 

1. 

1. 
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Fig. 4.16 Click Green Checkbox and then Click OK

You then get a summary of what will be joined, with the option to remove the original records

from the incident. In the case like this, of joining two calls, you are going to want to use the

default setting to remove the original two from the incident. The original calls remain on the

recorder, but are replaced in the incident with the new joined call. The call grid will be updated

with the new call as well.

 

Fig. 4.17 The Calls are Now Joined

4.7.3. Splitting Calls with Incident Clip Management

Here we will tackle the other common scenario: a pair of calls that are joined together because the Vox

hold time was set too long and the calls were very close together in time:

1. 
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Fig. 4.18 Example of Calls Improperly Merged Because of Vox Timeout

As above, click the call and use the context menu to Split/Join Media, and then adjust the

boundaries to surround the first call, click the green check mark.

 

Fig. 4.19 Adjust Split/Join Area

In this case, we want to uncheck the default “Remove original record(s) from incident” option: we

want the original to remain in the incident for the next step. We are going to crop a second call

out of it and at that point we will use the default setting to remove the original.

1. 

1. 
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Fig. 4.20 Uncheck “Remove original record(s) from incident”

Click OK. The selected area is now added to the incident as a separate call. The original remains.

 

Fig. 4.21 First Call Split, Original Call Remains

Again, use the context menu to click Split/Join Media and select the second call’s audio area.

 

Fig. 4.22 Select and Split the Second Call

Click the green check mark and click OK on the prompt (leaving the default setting.)

1. 

1. 

1. 
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Fig. 4.23 Split the Second Call and Remove the Original Call from the Incident

Now both calls exist in the incident as separate call records, shown accurately in the timeline and

call grid.

 

Fig. 4.24 The Calls are Split

4.7.4. More about Incident Clip Management

Calls that have been split or merged with Incident Clip Management will appear in search results at the

same time as the original calls. Incident Clip Management calls are always displayed on top in the

timeline; they are also highlighted with a yellow border, as seen in the screen shots above. Enabling the

call grid column Is Clipped will also let you quickly see whether a call was modified with Incident Clip

Management or not.

In an incident, you can quickly access the original version of a clip by right-clicking it and selecting

“Restore Original Media” to bring all original calls involved into the incident. There is an option to

remove the clip from the incident in the same step.

If a clip is no longer useful (or created wrongly in the first place) it can be deleted from the recorder by

right-clicking it and selecting “Delete Clip.” It is important to note that if a clip is used in multiple

incidents, it will no longer be available in any of them.

1. 
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4.8. Pinning Media to an Incident

Multimedia in an incident can be “pinned” to the canvas, such that they are always shown when the

incident is loaded. This is so that important events in an incident can be highlighted for future research.

In an incident, a multimedia record, such as a screen capture, will playback in a panel that has these

options in the upper right corner:

 

Fig. 4.25 Multimedia in an Incident (Detail)

The left most of these icons is the Pin to Incident button. If you click this, the frame around the media

will turn grey and the Pin to Incident and the Pop Out to Application will disappear:

 

Fig. 4.26 Pinned Multimedia in an Incident (Detail)
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4.9. Exporting an Incident

Incident Export exports the entire incident based on the export default. The only difference is that it

always selects “All Media” on the first panel because otherwise it would only export the currently

selected calls. If you want to modify the export settings from the default, you can click the Back button

to adjust any of them.

 

Fig. 4.27 Export Incident

Exporting an incident with this button will also include all attached files in the resulting zip file rather

than requiring you to download each one individually from the Properties and Notes page.

For more details on Exporting, see Exporting Recording Data from an Incident.

4.10. Deleting an Incident

To delete a incident in mediaworks, navigate to File -> Open Incident. A window will pop up with all the

incidents that have been created and saved. Simply right click the incident and select “Delete”.
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Fig. 4.28 Delete Incident
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5. UPDATING RECORDINGS

Once recordings have been collected into incidents, there are a number of ways to examine their

properties. Examine detailed properties for any recording by right-clicking a recording and selecting

Properties from the menu. The Properties dialog box will appear, allowing you to add information such

as notes and to access the audit history of the recording.

Any notes modified in this dialog box are saved back to the recorder on which it originated. Similarly,

changing the Protected status of a recording updates the recording’s status on the source recorder.

5.1. Call Properties

The Call Properties screen lists the attributes of the selected call recording and includes the following

tabs:

Properties: provides information about the call properties.

All: allows you to add information about the call to default or custom metadata fields.

History: Provides a history of the call.

5.1.1. Properties

The Properties tab provides detailed information about the recording’s location, time, and phone.

Checking the Protected box in the Attributes section will prevent the recording from being deleted by

the configured retention settings.

You may add information about the recording in the Notes box. You can also add custom fields at 

Recording → Custom Fields in Configuration Manager. Custom text fields with a Text Display Type of

Standard, Long, or XML will appear here in the properties tab.

• 

• 

• 
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Fig. 5.1 Call Properties – Property Tab

5.1.2. All

The All tab includes the custom fields specific to your recorder that contain additional information

about the recording. From this screen, you may edit any of the custom field information.

 

Fig. 5.2 Call Properties – All Tab
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5.1.3. History

The History tab provides an audit history of each time this recording has been accessed, including the

related user information.

 

Fig. 5.3 Call Properties – History Tab

5.1.4. Edit Call Properties

New in 2022.1, MediaWorks DX now offers the ability to configure, edit, and add new Call Property

tabs in order to give quick access to a user’s data and feedback.

Configure Call Properties

To configure your Call Properties, highlight a track and select “Edit Call Properties” under Menu Bar ->

“Tools”
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Fig. 5.4 Call Properties Configure

When you select the settings icon in the top right corner, you’ll be able to Customize your Properties

tabs to add and organize detailed information that your user needs as well as add additional header

sections and adjust layout between single columns, double columns, or annotation sections.

Add Additional Call Properties

To add more tabs to your Call Properties, select “Edit Call Properties” in the Menu Bar, and select the “+” in

the top right corner. This will give you the ability to add new tabs, create multiple headers within each tab,

and apply new fields within each of those sections.
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Fig. 5.5 Call Properties New Tab

5.2. Editing Call Notes in the Call Grid

If you make the Note column visible, you can edit call notes directly in the call grid by double clicking on

the field associated with a call. If you want to edit the note for the next call, hit enter to finish this note

and move to the next. Once you have a note entered in one or more calls in a given search or incident,

you can also reuse previous notes by clicking on a call then opening an autocomplete menu that will list

the notes from other calls in this view, as seen below.

 

Fig. 5.6 Note Autocomplete Menu
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5.3. Annotating Calls

Annotation allows you to make notes in a recording at the precise time in the recording that is of

interest. For example, you can mark where someone on the line starts yelling, or when a sound in the

background caught your attention. Annotations are visible on the timeline as a little yellow pin marker,

and if you hover your mouse over them, the text will pop up, in this case “A comment about this

moment in time.”:

 

Fig. 5.7 Text Annotation in the Timeline

Annotations are paired to the call, so the pin will be visible in any search, browse or incident that

includes it. To add an annotation, right-click on the call and select Add Text Annotation. This will open

the Annotation editor, with the Date set to the time of where you initially clicked.

 

Fig. 5.8 Editing an Annotation
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You can adjust the time alignment by configuring the date in this window; if you want the annotation to

precisely align with the start or end of the call, you can use the left (start) and right (end) arrows around

the date to set it to the start or the end.

When looking at the properties of a call record that has been annotated, a list of these annotations will

appear at the bottom of the properties window.

 

Fig. 5.9 Properties showing Annotations

5.3.1. Audio Annotations

Annotations can also include audio, if you have a microphone attached to your computer and are using

Firefox, Chrome, or Edge (Chromium). Internet Explorer does not support the necessary web

technologies for this feature to work.

For privacy reasons, using a microphone with MediaWorks DX requires that you grant explicit

permission to the web browser to use the microphone; this is handled by the browser. It also requires

HTTPS.
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Fig. 5.10 Audio Annotation Microphone Permission Prompt in Firefox

 

Fig. 5.11 Audio Annotation Microphone HTTPS Prompt

Audio Annotations can include text like a regular Annotation, but by using a microphone you can

provide commentary on any call, at any point in the call. Right click on the call in the timeline at the

point you wish to annotate, grant permission to the microphone (once per session) and then click the

button with the red dot in a circle to start recording.

Once you are recording, the timer on the side will count up to the maximum of 60 seconds of recording

time. Click the same button again to stop recording. You can then playback the recording by pressing

the play icon (triangle) in the audio widget that appeared after clicking stop.

You can delete the recording by pressing the red X circle button and you can save by clicking OK.

Playback the call and you will hear the audio annotation, surrounded by a beep at start and end, at the

point in the call you placed it.
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Audio Annotations are played back by default but can be turned off in the Playback menu.

 

Fig. 5.12 Audio Annotation Error: No Microphone
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6. EXPORTING RECORDING DATA FROM AN
INCIDENT

MediaWorks DX can export recording data from a recorder in a number of different formats. Although

you can export from the Search and Browse tabs, the preferred way to export data is to first create an

incident containing the recordings you wish to export. Refer to Section 4: Creating an Incident for

additional information. Once an incident has been created, select Export… from the Tools menu. The 

Export Media dialog box will appear Fig. 6.1. You can also right-click on the selected recordings in the

Record view and choose Export… from the menu.

6.1. The Export Dialog Box

To export recordings:

First: in the Export Media dialog box, Select media, will be highlighted. Select All media in your

record list? to export the media for all the recordings in the incident, or select Only selected

media in your record list? to export only selected recordings in the incident.

By default, a text file listing the calls and metadata will be included in the resulting zip file; this can

be exported as a PDF as well. The PDF option allows you to configure which Metadata Columns

to include in the PDF, as this may need to be adjusted to fit the data onto a single page.

You can also choose to Include Attachments, for incidents that include attached files. Make your

choice and then click the Next > button.

1. 

2. 

3. 
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Fig. 6.1 Export Media Dialog Box Step 1

Second: Select File Divisions, will be highlighted. You may select One file per record (sequential), 

one file for the entire record list (sequential), which exports all the calls back to back in order in

one file, One file for the entire record list (mixed), which means it is presented in real time with

overlapping calls audibly overlapping, or One file per resource (mixed), which exports a single

mixed file for each resource involved in this export.

The two Mixed exports have additional options that do not apply to the sequential mode: Skip

Inactive Periods and Apply Boundaries. Skip inactive periods will skip any part of the export that

would have been silent, useful when exports have long periods between calls. Apply Boundaries

allows you to crop the export to a shorter duration than the data set chosen in the first step.

Make your choice and then click the Next > button.

1. 
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Fig. 6.2 Export Media Dialog Box Step 2

Select Export Options, will be highlighted. Here you can select Time Markers (and then choose

the desired time marker modes), choose to use the timeline playback settings, and set the file type

to save as. In the File output encoding box, select the type of data compression scheme you want

to use. If you have purchased and entered an add-on license for MP3 encoding, MP3 will be an

available choice in this menu.

The Use timeline playback settings and apply redaction areas option is on by default and will

cause exports to sound the same as they do when played back in the same mode as the export,

including volume adjustments, AGC, panning and redaction areas. The Export Audio Annotations

option will include any audio annotations present on the calls being exported.

After selecting the audio options, click the Next > button.

1. 
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Fig. 6.3 Export Media Dialog Box Step 3

Fourth: Select destination, will be highlighted. Enter a file name for the export, and select Export

to File, Export to Data CD/DVD/Blu-Ray or Email Export. Export to File will create a zip file

containing the exported calls for use on your computer. Export to Data CD/DVD/Blu-Ray will

create an ISO that can be burned with standard cd burning software to the appropriate media for

the size of the export; the export dialog will show you whether the estimated size of the export

will fit on each of the kinds of media. Email Export will create a EML file that will automatically

open in your computer’s configured default email client.

Note: You can configure your default email client in the system preferences of the operating

system you are using, for example in Windows 10, it can be found in Control Panel: Default

Programs.

1. 
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Fig. 6.4 Export Media Dialog Box Step 4

Optional: The export destination can also be Eventide AutoUnpacker. See below for details.

Optional: Export Presets and Defaults can be configured from here. See below for details.

Finally, click on the Export button to export the recording data; it will be downloaded to your

browser’s default download location on your PC. If you selected Export to File, it will download as

a zip folder containing the audio file or files you requested.

If you selected Export to Data CD/DVD/Blu-Ray, the file downloaded will be an ISO file that you

can use Windows Disc Image Burner to burn to cd or DVD. If you have a Blu-Ray drive please use

the image burning software that it came with.

6.2. Eventide AutoUnpacker

Exported media can be automatically downloaded and decompressed to your defined default location

by using Eventide AutoUnpacker. To use this option, it must be installed and enabled first from the Tools

menu under Eventide AutoUnpacker.

1. 

2. 

3. 

6. EXPORTING RECORDING DATA FROM AN INCIDENT 85



 

Fig. 6.5 Tools → Eventide AutoUnpacker

Once AutoUnpacker is enabled and installed, you can select one of the two options for exporting.

Use Default Location

Uses the default export location that was defined in the installed application. Exporting this format will

download a file with a “.eaud” extension. If your browser is set to open this file automatically after

downloading, then your exported media directory will automatically open when finished.

Choose Export Location

If your media needs to be exported to a location different from your default, then select this option.

Exporting in this format will download a file with a “.eau” extension. This file type will open the

AutoUnpacker utility so that you can browse to your desired export location.
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Fig. 6.6 Eventide AutoUnpacker Utility

For more information on how to install and use the Eventide AutoUnpacker, refer to the Eventide

AutoUnpacker Installation/User Guide available from Eventide Support.

6.3. Export Presets and Defaults

Regularly used Export settings can be saved, both as a default setting that will load every time the

Export dialog is opened, and as individual Export Presets that can be selected from the “Export Using

Preset” menu option. Defaults and presets are saved at the last panel of the Export dialog.
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Fig. 6.7 Saving Export Default and Presets

Clicking the Export Presets… button will prompt you to save the current settings as either a default

export configuration or as a named preset. Once an Export Preset has been saved, the Tools menu and

the right-click context menu will have a new Export Using Preset option that allows you to choose a

preset to load.
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Fig. 6.8 Export Using Preset Menu Option

Selecting an Export Preset will open the Export dialog to the final page, where you enter the export

name and choose the file type (zip, ISO, eml.) You are however free to use the back button to make any

adjustments to the settings that you wish for this export.

You can overwrite an existing preset by saving a newly created one with the same name. You will be

prompted to be sure, and if you click yes, it will overwrite the previous preset. To delete a preset, select

that preset from Export Using Preset and then click Export Presets; instead of a field to save a new

preset, you will see the option to delete this preset.
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Fig. 6.9 Deleting an Export Preset

6.4. Email Export

You can choose to export to an .eml file that you can open with your email client of choice. It will create

an email with the export’s contents attached. Note that your email provider usually has a limit set on

the size of email attachments, so this option is most useful for small exports.

6.5. Export Single Recording

Available from the Tools menu and the right-click context menu, Export Single Recording exports the

currently selected call, with current playback and timeline settings, including volume adjustments, AGC,

panning and redaction areas. This is a quick way to export a single call at a time without any additional

steps or menu-diving.

6.6. Screen Capture Export

Screen capture recordings can be exported much like audio recordings, but there are some caveats.

Recordings from multiple screen resources cannot be mixed together. Screens from the same channel
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can be merged into a single mixed mode export. Audio calls can be mixed with screen recordings from a

single screen resource. If part of the export overlaps such that there is audio with no video, the video

will be black during that time.

There are four encoding types for screen export. The first two, MPEG, High and Medium, are much

higher quality in a much smaller file size, but require VLC or Chrome or other third party software for

playback. The second two, AVI Low and Medium Compression, will work on a stock Windows XP

system, but the quality is lower and the file size is very large. These options are included to allow for

maximum compatibility.
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7. MONITORING A RECORDER

MediaWorks DX allows you to monitor the live audio feeds on the recorder. In addition, you can view

the status of channels, and (if permitted) manually enable/ disable recording on channel(s) for record-

on-demand purposes.

7.1. Channels Tab

The Channels tab displays all physical channels in a list and provides live status information for all

physical channels on the recorder. To open a new Channels tab, select New Tab → Channels from the 

File menu.

To sort the list of channels, click on either the Channel Name or Channel Number header; a small arrow

will indicate the sort direction. To reverse the sort, click the header section again.

Each channel is displayed with the Channel Name, Channel Number, and current Channel Status. To

enable live monitoring of the data currently playing on a channel, click to toggle the Live Monitor icon

for the selected channel. Multiple channels can be monitored simultaneously. Adjust the overall volume

level using the volume slider at the bottom of the window.

To enable recording on a channel, check the Record Enabled checkbox. If the checkbox is deselected,

any audio currently being recorded will stop until the Record Enabled checkbox is re-checked.

 Note

The Record Enabled feature is heavily restricted, and must be configured explicitly for each user,

even those with Administrator rights, in Configuration Manager. This is to prevent accidental use

of the feature.

The status of each channel is displayed in the Channel Status column. A colored square indicates the

status. The colors correspond to the following states:

Green – The channel is enabled, but not currently recording any audio.

Red – The channel is enabled and is currently recording audio.
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Yellow – The channel is user disabled.

Grey – The channel is disabled by the system or is not recognized. Consult your system

administrator for details.

You may add more columns by right-clicking on any area in the column headers and selecting one or

more new columns from the drop-down list of column names. Check the box associated with each

column name you wish to add and the new column will appear in the Channels tab. To remove a

column, uncheck the box associated with that column.

7.2. Instant Recall Tab

The Instant Recall tab, as seen below, provides a live window into the activity on one or more channels.

The most efficient method for monitoring a recorder with Instant Recall is to create one tab per filter.

See Resource Search Groups.

 

Fig. 7.1 Instant Recall Tab

To open a new Instant Recall tab, select New Tab from the File menu and select Instant Recall from the

drop-down list.

The Instant Recall tab’s main controls are positioned at the top of the screen and include:

The Choose Channels… button, which will pop open a list of Search Filter Groups and resource

names to filter the call resources shown in the instant recall window.

An adjustable time range that allows you to set the time window for which records will appear.

• 

• 
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Fig. 7.2 Choose Channels… pop up menu

The records displayed in the record view will correspond to the selected filter, and will also correspond

to the specified time range.

The Choose Channels… pop up menu lists your Search Filter Groups first and then each named

resources. The channels viewed are selected via mouse click; use Ctrl+Click or Shift+Click to select

more than one at a time:

Clicking on Channel 1 and then ctrl+clicking on Channel 9 will select just Channel 1 and Channel

9.

Clicking on Channel 1 and then shift+clicking on Channel 9 will select Channel 1 through Channel

9.

To adjust the time range, enter a new value for Hours and Minutes. Instant Recall will automatically

refresh the record view. To change the channel that is displayed, select a new channel name from the

drop down list. The record view will again be automatically refreshed.

 Note

Depending on your user account, the amount of time you can set may be limited by your system

administrator.

• 

• 
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The Instant Recall record view can be customized by right-clicking on any area in the column headers. A

drop-down menu with a list of column names will be displayed. To add a new column, check the box

associated with the column name. To remove an existing column, uncheck the box associated with that

column name.

Columns can also be re-arranged. To move a column to a new position, click on the column header, hold

down the mouse and drag the column header to a new position, then release the mouse. The column

will then re-position itself.

7.2.1. Instant Recall Timeline

Each Instant Recall tab also includes a Timeline view in the bottom half of the page. This allows for all

the features standard to the Timeline view as seen in the Browse and Search tabs, as discussed in

chapter 1.4.4 The Timeline View, but also includes some special features unique to the Instant Recall

tab:

Per channel live monitoring of incoming call via Resource Name or Talkgroup.

Optional up to the minute timeline scroll.

Each resource in the Timeline has a speaker icon at the far right that can be toggled green to have it live

monitor all calls coming in with that resource name. This is different than the Channels tab, which is by

physical id number only.

• 

• 
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Fig. 7.3 Instant Recall Timeline (Detail)

The blue arrow in the right corner toggles whether the display of the timeline is locked to the current

time or not. It will automatically turn off if you play a call in the timeline or scroll into the past, and if

you then click it, it will jump forward to display the current time. It will also turn back on if you live

monitor a resource, or if you scroll all the way up to the right to the current time.

 

Fig. 7.4 Up to the Minute Arrow (Left is On, Right is Off)
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8. GEOLOCATION FEATURES

Call records can now be tagged with location metadata and that data can be used to visualize where

calls are coming from. The location data can also be used as criteria for searches.

8.1. Geo-Display

The View menu includes an option called “Enable Geo-Display.”

 

Fig. 8.1 Geo-Display

On a system with a Geolocation add-on license and location metadata, when Geo-Display is first

enabled it will open the Geo-Display popover window, shown in the above figure, featuring a map and

pin marks for call records in the current timeline that are tagged with location data. Note that Geo-

Display is supported in all tabs except Evaluations and Channels.

The + icon will expand the Geo-Display to cover as much of the browser page as possible, and the – will

bring it back to the default smaller size. With the X, the window can be minimized to a Globe button

just above the call record grid in all tabs that support Geo-Display, as seen in the figure below, next to

the “5 records, 0 selected”:
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Fig. 8.2 Geo-Display Button

The Geo-Display defaults to showing you pin points for each call record, on a street map. These pins

can be clicked on to select the record in the call record list and in the timeline, double-clicked to play,

and right-clicked to access all the context menu options you have when right clicking from the timeline

or call record list. Much like on the timeline, selected records are displayed as blue pins and the

currently played call is green.

Additionally, the Geo-Display offers other display options, if you click the white + in a blue box near the

top right corner:

 

Fig. 8.3 Geo-Display Options

The Base Layer options allow you to toggle between Google’s Satellite and Streets views. The Satellite

view shows you the actual terrain, whereas the Streets shows you a street map.
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The Heatmap option shows you your data in shades of color generalized by density of results. It is more

useful when looking at a lot of data at once; with enough call records, individual pins will pile up into a

mess, but a heatmap will show you hotspots where more of your calls are coming from. It’s easier to

understand with a picture:

 

Fig. 8.4 Geo-Display Heat Map

The dark blue areas show you one or two calls, but the bright green areas show you where calls came in

repeatedly during the time covered by this search.

8.2. Geo-Fence

The Search tab includes a Search Filter option called Geo-Fence:
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Fig. 8.5 Geo-Fence in Filters Menu

The Geo-Fence allows you to draw shapes on a map, which will be used to filter search results to just

that territory:
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Fig. 8.6 Geo-Fence with Polygon Selection in progress in blue

For better ease of use, you can pop this Geo-Fence out into its own window inside the MediaWorks DX

browser page:

8. GEOLOCATION FEATURES 103



 

Fig. 8.7 Geo-Fence (with a polygonal and a circular search area in orange)

There are five tools and an Options menu in the upper right corner of the Geo-Fence:
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Fig. 8.8 Geo-Fence Tools and Options

These tools are, from left to right:

Circle: Draws a circle on the map, with the initial click being the center and then the circle’s size is

determined by dragging away from the initial click.

Polygon: Each click becomes a point of a polygon, allowing for customized shapes. Double click a

point to finish the polygon.

Point: This creates a circle of pre-determined size. The default is 3 miles but that is configurable in

the Geo-Fence options.

Hand: The Hand tool is used to drag the map around.

Clear: This X icon will clear existing shapes and allow you to start over or search without the filter

active.

The Geo-Fence options are the same the Geo-Display options, but also include Search Settings:

Single Mode: This restricts the search area to a single area at a time; making a new search area will

delete any previously created search area in favor of the new one.

Point Search Miles: This is the size for the Point tool. It defaults to 3 miles.

Save Location and Settings as Map Default: This saves current settings and location as the default,

so that every time you open a map it’ll show the area currently shown with the settings as they

are.

1. 

2. 

3. 

4. 

5. 
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3. 
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Here is an example of a search made with the point tool:

 

Fig. 8.9 Geo-Fence Made With 3 Mile Point

8.3. Radio ID Display for Instant Recall

The Geo-Display feature Show Radio IDs only works with Instant Recall tabs:
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Fig. 8.10 Geo-Display in Instant Recall

This feature allows you to see Talker ID and Group ID (or really any Metadata field) on the associated

call pin as calls come into the recorder. The recall minute setting controls how long this data shows on

the map, fading over time so that the latest calls are the most prominently displayed.
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9. RESOURCE SEARCH GROUPS

A “Resource Group” is a NexLog policy management tool that groups together resources/channels on

the recorder and allows different rules to be applied to them. Search Filter Groups are a special kind of

Resource Group, which make large channel count systems easier to interact with by grouping existing

resources into easily searched groups. To differentiate these from the Saved Search Filters feature of

MediaWorks DX, they are referred to as Resource Groups in this context.

Resource Search Groups can be edited via the Tool menu at any tab. They are also Edit Resource

Groups… options in contextually useful places on the Search and Instant Recall tabs, as described

below. Finally, Search Filters can also be edited from the Configuration Manager on the Resource

Groups page and User Edit pages; see the NexLog DX-Series user manual for more info.

9.1. Creating Resources Groups for Search

The Edit Resource Groups option in the Tools menu allows you to edit Resource Group Search Filters,

you will see this window:

 

Fig. 9.1 Edit Resource Groups Window

There is a similar Edit Resource Groups… option in the Choose Channels… menu on Instant Recall tabs,

which opens the same window. The Edit Resource Groups window has two columns. The left column

contains a list of search filter groups configured to be available for the current user. The right column

contains in bold all existing filter groups not configured for the user, and in plain text the available
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channel resources, first the physical channel ids and then by resource names. The physical channel ids

are formatted like this:

[source] channel id “current name of resource”

Such that the first physical channel on the recorder itself will default to:

[local] 1 “Channel 1”

The << and >> buttons are used to move filter groups, channel ids and resources between the two

columns.

From this edit window, you can add and delete Resource Groups in several ways. The first is to click the

New Group button. This will prompt you to name the group, then click ok. An empty group of the name

entered will be created. You can also right click an existing group and select Add New Group

 Note

Resource Groups can only be deleted by Administrators and users with access to the Resource

Groups page of the Configuration Manager.

9.2. Adding Resources to Resource Groups

From this edit window, you can add resources to a Resource Group in several ways:

The named resources and physical channel numbers in the right column can be clicked on to

select them. Use Ctrl+Click or Shift+Click to select more than one at a time. Highlight a group in

the left column by clicking on it. Then add the selected resources by clicking the leftward facing

arrows between the columns.

You can select resources and click+drag them from the right column into the group you want

them to be added to.

You can right-click the name of the group and select from a menu, as seen in the figure below.

From this menu, you can add a Name Filter, using * as a wild card to match multiple resources by

name.

This menu also allows you to add a Channel Filter, with which you can specify a range of

resources by physical channel ID and their source, which defaults to Local. The source field is only

relevant to configurations involving resources on the recorder originating from Centralized

• 

• 

• 

• 

• 

• 
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Archive sources; if you want to group these, enter the serial number of the Centralized Archiving

source into this field. Click the X to cancel and the Checkmark to save.

 

Fig. 9.2 Edit Resource Groups: Right Mouse Button Menu

For example, if you have some channels dedicated to Fire calls and others dedicated to Police, you can

create a Resource Group for the Police channels, and another for the Fire channels and quickly search

all calls on one group of channels.

9.3. Deleting a Resource from a Resource Group

You can delete resources from a Resource Group in two ways. First expand the group in the left column

and then:

Select the resources you want to remove from the filter and then click the >> button between the

columns. Right-Click on the group and select Remove Filter from the pop up menu.

9.4. Using Resource Groups

These filter groups now show up in the channel selectors for Browse, Search and Instant Recall.

Updates made to Resource Groups are live and do not require a refresh of the browser to take effect.
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Fig. 9.3 Resource Groups: In Browse, Search, and Instant Recall
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10. NEXLOG ACCESS BRIDGE

 License Required

This feature must be licensed to be used. Contact your Eventide Dealer for assistance.

MediaWorks DX can be used to access recordings across multiple recorders at once using NexLog

Access Bridge (NAB). With NAB, NexLog Recorders can be bridged together to allow access to media

across systems from one instance of MediaWorks DX, and if the same User & Password is used across

systems, one log in. For example, one system can be a dedicated screen recorder, and another can

record related phone calls, and both sets of recording can be browsed and played back at the same

time, from the same MediaWorks DX window.

NexLog Access Bridge requires a NAB License on the primary recorder and a MediaWorks DX license

on each of the source recorders.

10.1. Connection Information

The Connection Information window shows you all the NexLog systems and archives that are currently

configured or available to connect to at this moment. This includes all configured NexLog Access

Bridges and all Archives attached to the base system and put into Playback mode via the Browse button

the Front Panel or from the Archives page of Configuration Manager.

You can access Connection Information by selecting Connection Information from the View menu. If

you turn on Show Connection Icon, a small Connection Icon will show up next to the user name in the

upper right and you can click on it to bring up the Connection Information window at any time. The

column headers are Recorder Name, Username, Serial, Status, Location, Ping(s), Connect Now, and

Connect on Startup.
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Fig. 10.1 Connection Information Window

Most of the headers are self-explanatory: for example, Recorder Name and Serial are the name and

serial of the configured recorder. The Username is the user name you are currently logged in to this

source as. The Location is the IP address of this recorder. Status and Ping(s) are interesting because you

can click on any entry under this field and get more information: a list of the previous statuses and the

previous ping durations. In the example below, you can see the connection history of a recorder that

was improperly configured (the wrong serial number was entered in the NAB config page) and

succeeded after being reconfigured (the correct one was entered.)

 

Fig. 10.2 Connection Information Status History

Connect Now and Connect on Startup allow you to manage your connections to bridges and archives. If

Connect Now is unchecked, you are disconnected from the source (and Status should then say

Disconnected or Unavailable.)

If Connect on Startup is checked, an attempt will be made to log in to that source whenever MWP on

the base recorder is logged into by this user. If the user credentials for the base recorder are not valid

on the source, there will be a prompt to log in with a different name and password.
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When there is a problem with a connection, you will be prompted with a warning detailing why, and

then given the option to Login, Ignore, and Logout. If, however you also have unsaved incidents or

evaluations, it will prompt you just to Login or Logout.

Login will prompt you for credentials to log in with; if you were already logged in as a specific user, you

will be required to log in as that user, to maintain continuity of permissions during this session.

Ignore will cancel the attempt to connect to this source. If you want to, you will then have to manually

re-connect via the Connection Information window.
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11. ARCHIVES

Archives can be accessed via MediaWorks DX.

To connect to an archive, load the archive as appropriate for the kind of archive on the NexLog DX-

Series system, then use the browse button to load the archive into “Playback” mode. The archive will

then connect automatically for MediaWorks DX users who have permissions to read from archives.

You can disconnect an archive via Connection Information.

 Note

Creating Incidents and Evaluations of archived calls are not currently supported.
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12. USER CONTENT UPLOADS

 

Fig. 12.1 User Content Upload

User Content Uploads allows a user to upload media to a NexLog DX-Series recorder channel, and use

that media for incidents, evaluations, or general playback.

This feature is intended to assist a user by having all incident data in a central place.
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 Disabled by Default

User Content Uploads require additional licensing and must be enabled in the NexLog DX-Series

Users and Security -> System Security general configurations. See the NexLog DX-Series User

Manual or Contact your Eventide Dealer for assistance.

 

Fig. 12.2 Enable User Content Upload

12.1. Uploading Content

Content or media can be uploaded by right-clicking in the call grid or timeline, then selecting Upload

User Content.
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Fig. 12.3 Add Media

Multiple files can be uploaded by dragging them into the designated area, or by clicking the plus sign.

12.1.1. Edit User Content

Once content has been uploaded the user may set the basic information for it.

 

Fig. 12.4 Edit User Content

Incident Only: Make the uploaded content only available to the current incident that it was

uploaded to.

• 
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Resource Name: Set the resource or channel name that the content should be attached to.

New Resource: Enter a new resource or channel name instead of reusing an existing one.

Custom Start Time: Set the content to begin at the time the user right-clicked from, or selected

with the calendar button.

Suggested Start Time: Set the content to begin at the timestamp embedded in the file’s metadata.

Once content has been uploaded, only the Resource Name and Start Time can be set.

• 

• 

• 

• 
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13. MORE ABOUT MEDIAWORKS DX

13.1. Columns

Any data displayed in tabular format, particularly lists of recordings available in the Browse, Search,

Incident, and Channel tabs, can be sorted in ascending or descending order, if applicable, by clicking on

the header for that column. An indicator arrow will appear in that column indicating the sort direction.

To change the sort direction, click on the column header again.

You can also sort columns by a secondary sort by shift  + clicking a second column. For example, you

may want to sort by channel name and then by start time; you would click Channel Name first, then

hold down the shift  key and click the Start Time (Local) columns. You can change the secondary sort

by again shift  + clicking, or you can cancel the secondary sort by clicking on any column, which will

then be the only sort criteria.

Columns can also be re-arranged. To move a column to a new position, click on the column header, hold

down the mouse, drag the column header to a new position, then release the mouse. The column will

then re-position itself.

You can set the default columns for each tab selecting View → Column Defaults in the top menu bar.

 

Fig. 13.1 Column Drop-Down List
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The presentation of recordings in the Browse, Search, and Incident tabs can be further customized.

Right-clicking on any area in the column headers displays a drop-down menu of possible column names.

To add a new column, check the box of the associated column name. To remove an existing column,

uncheck the box associated with that column name.

13.2. Calltype

Calltype is a feature that automatically tags records with an image representing the kind of recording it

is. By default, recordings made on Analog Recording cards will be tagged with Audio, T1/E1 with Phone,

screen capture with Screen. The default calltype for VoIP is dependent on the VoIP template used.

Default calltypes can also be set on per resource or channel name in Resource Groups. See the NexLog

DX-Series User Manual for more information.

In MediaWorks DX, these icons will appear in the timeline if Show Calltype in Timeline is checked in the

View menu. You can see the calltype column by making the column visible as you would any custom
field by right-clicking in the call grid header and selecting calltype from the list.

 

Fig. 13.2 Calltype in Timeline

Audio recordings can also have a different waveform color for each calltype.

Default calltypes icons and a corresponding waveform color can be set at Recording → Custom Fields →

Calltype in Configuration Manager.

See the section about Calltype in the NexLog DX-Series User Manual for more information.
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13.3. The Menu Bar

The Menu bar is located at the top of the MediaWorks DX window. Several menu selections have

shortcut keys associated with them and are displayed to the right of the menu selection. Also, if a menu

selection includes an associated shortcut key, the shortcut key is shown parenthetically in the following

descriptions.

The Menu bar includes the following menu items: File, Edit, Tools, Playback, View, and Help.

13.3.1. File Menu

 

Fig. 13.3 File Menu

Selecting File from the Menu Bar provides the following menu items:

13.3.1.1. New Tab

The New Tab menu item opens a new tab in the active top-level window. Choose a tab name from the

list that appears. The list includes:

Browse ( ctrl  + b )

Search ( ctrl  + t )

Incident ( ctrl  + i )

• 

• 

• 
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Channels ( ctrl  + l )

Evaluations ( ctrl  + g )

Scheduled Evaluations

13.3.1.2. Open Incident

Keyboard Shortcut: ctrl  + o

The Open Incident… menu item opens an existing remote incident in a new tab.

13.3.1.3. Close Tab

Keyboard Shortcut: ctrl  + w

This menu item closes the active tab. You cannot close the last tab.

13.3.1.4. Save Incident

Keyboard Shortcut: ctrl  + s

The Save Incident menu item saves the active incident. If an Incident tab is not active, this option is not

available.

13.3.1.5. Save Incident As

Keyboard Shortcut: ctrl  + alt  + s

This menu item saves a copy of the active incident by prompting for a new incident name. If an Incident

tab is not active, this option is not available.

13.3.1.6. Logout

Keyboard Shortcut: ctrl  + q

• 

• 

• 
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Selecting the Logout menu item logs the user out of the NexLog recorder, and will go back to the initial

splash screen with a login prompt. There is an “Are you sure” prompt.

13.3.2. Edit Menu

 

Fig. 13.4 Edit Menu

Selecting Edit from the Menu Bar provides the following menu items:

13.3.2.1. Select All

Keyboard Shortcut: ctrl  + a

The Select All menu item selects all recordings in the active tab.

13.3.2.2. Remove From Incident

Keyboard Shortcut: ctrl  + d

Selecting the Remove From Incident menu item removes the selected recordings on the active Incident

tab. If an Incident tab is not active, this option is not available.
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13.3.2.3. Incident Properties

Keyboard Shortcut: ctrl  + j

The Incident Properties menu item invokes the Incident Properties dialog box on the active Incident

tab. If an Incident tab is not active, this option is not available.

13.3.2.4. New Incident from Selected Records

Keyboard Shortcut: ctrl  + shift  + i

This menu item creates a new Incident tab in the active window containing all the selected recordings.

If a list of recordings is not available in the active tab, this option is not available.

13.3.2.5. Set Loop Start to Current Time

Keyboard Shortcut: ctrl  + [

This selection sets the “loop start” point to the value of the current playback time. This is only available

on those tabs that can play audio from a recording.

13.3.2.6. Set Loop End to Current Time

Keyboard Shortcut: ctrl  + ]

This selection sets the “loop end” point to the value of the current playback time. This is only available

on those tabs that can play audio from a recording.

13.3.2.7. Set Export Start to Current Time

Keyboard Shortcut: ctrl  + shift  + [

This selection sets the “export start” point to the value of the current playback time. This is only

available on those tabs that can play audio from a recording.
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13.3.2.8. Set Export End to Current Time

Keyboard Shortcut: ctrl  + shift  + ]

This selection sets the “export end” point to the value of the current playback time. This is only

available on those tabs that can play audio from a recording.

13.3.3. Tools Menu

 

Fig. 13.5 Tools Menu

Selecting Tools from the Menu Bar provides the following menu items:

13.3.3.1. Export

Keyboard Shortcut: ctrl  + alt  + e

13. MORE ABOUT MEDIAWORKS DX 129



This menu item opens the Export Media dialog box for the current list of recordings. See Section 6:

Exporting Recording Data from an Incident for additional information.

13.3.3.2. Export Using Preset

This menu item opens the Export Media dialog box for the current list of recordings with the preset’s

settings selected. See Section 6: Exporting Recording Data from an Incident for additional information.

13.3.3.3. Export Multiple Incidents

Keyboard Shortcut: ctrl  + alt  + e

This menu item opens the Export Multiple Incidents dialog box, including a scrolling list of selectable

incidents on the recorder and options for exporting more than one of them at a time. See Section 6:

Exporting Recording Data from an Incident for additional information.

13.3.3.4. Print/Export Records

This menu item opens the Print/Export Options dialog box, including a choice of format for the export

(xlsx, pdf, csv), which columns and what audit information to include. This only exports record metadata

and not the audio.

13.3.3.5. Edit Search Filters…

This menu item opens the Search Filters window. See Section 2.4: Saved Search Filters for additional

information.

13.3.3.6. Edit Resource Groups…

This menu item opens the Edit Resource Groups window. See Section 9: Resource Search Groups for

additional information.
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13.3.3.7. Edit Date Formats

This menu item opens the Date Format Options window. This window allows you to customize the way

dates and time are formatted throughout MediaWorks DX. We recommend leaving out the day, month

year from the Instant Recall Date Format because Instant Recall will always be displaying calls from the

very recent past.

 

Fig. 13.6 Date Format Options

The default global date time format is: YYYY-MM-DD HH:mm:ss Z

YYYY: Four digit year

MM: Two digit month

DD: Two digit day

HH: Hours (24 hour clock)

mm: Minutes

ss: Seconds

SSS: Milliseconds

Z: offset from GMT time

The hyphens and colons in between the variable names are shown as is.

The Load Defaults button will restore the settings to the default. The examples show how other variable

names can be used to get other results. If you have more complex date needs, contact Eventide support

for additional information.

• 

• 

• 

• 

• 

• 

• 

• 
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13.3.3.8. Edit Default Permissions

This menu item opens the Edit Default Permissions dialog box so that you can change the default

permissions and call protection settings for Incidents and Annotations.

 

Fig. 13.7 Default Permissions

The Incident setting “Protect Calls on Save” option in Incident Properties controls whether or not calls

added to an incident after the initial save will be protected when the incident is saved. This defaults to

On when “Protect calls” is selected here, and Off when “Do not protect calls” is selected here.

13.3.3.9. Resource Gain Defaults

Opens the Resource Gain Defaults window. See Section 3.4: The Timeline View for additional

information about Resource Gain Defaults.

13.3.3.10. EQ Settings

Opens the EQ Settings window. See Section 3.4.4: EQ Settings for additional information.
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13.3.3.11. Eventide AutoUnpacker

Once Installed and Configured, this Windows software will automatically unpack and export media from

MediaWorks to your defined default location. requires Windows 7 or higher

13.3.3.12. Edit Call Properties

New for 2022.1, Call Properties can now be configured with customized information and layouts. See 

Section 5.1: Call Properties for additional information.

13.3.3.13. Change Password

Opens the Change Password window. Allows the user to change their password.

13.3.4. Playback Menu

 

Fig. 13.8 Playback Menu

13. MORE ABOUT MEDIAWORKS DX 133



Selecting Playback from the Menu Bar provides the following menu items:

13.3.4.1. Toggle Playback

Keyboard Shortcut: space

Checking the Toggle Playback box starts or stops playback. Starting or stopping playback in this way

applies to either playback mode and applies to any tab. The space bar on the keyboard can also toggle

playback on/off.

13.3.4.2. Start Sequential Playback

Keyboard Shortcut: ↵enter

The Start Sequential Playback menu item starts sequential playback at the selected recording. If there

is no selection, the first recording in the list will begin playing.

13.3.4.3. Start Mixed Playback

Keyboard Shortcut: shift  + ↵enter

The Start Mixed Playback menu item starts mixed playback at the selected recording. If there is no

selection, the first recording in the list will begin playing.

13.3.4.4. Next Record

Keyboard Shortcut: shift  + →

In sequential mode, Next Record skips to the next recording as listed in the record view. In mixed mode,

Next Record skips to the start of the next recording in time order.

13.3.4.5. Previous Record

Keyboard Shortcut: shift  + ←

134 13. MORE ABOUT MEDIAWORKS DX



In sequential mode, Previous Record skips to the previous recording as listed in the recording view, or

skips to the beginning of the current recording, depending on the time that the current recording has

been playing. If the current recording has been playing for less than 3 seconds, it will skip to the

previous recording. If the current recording has been playing for more than 3 seconds, it will skip to the

beginning of the currently playing recording.

In mixed mode, Previous Record skips to the start of the previous recording.

13.3.4.6. Skip Forward

Keyboard Shortcut: →

The Skip Forward menu item scrubs forward by a user-defined number of seconds (default is 10). In

sequential mode, scrubbing remains within the bounds of the currently playing recording.

13.3.4.7. Skip Back

Keyboard Shortcut: ←

The Skip Back menu item scrubs backward by a user-defined number of seconds (default is 10). In

sequential mode, scrubbing remains within the bounds of the currently playing recording.

13.3.4.8. Loop Playback

Checking the Loop Playback box loops playback between user-defined start and end looping points. In

Sequential mode, if no user-defined start and end looping points have been set, the entire recording will

be looped. If start and end points have been set within the recording, checking Loop Playback will

initiate loopback between these two points.

In Mixed mode, if no user-defined start and end looping points have been set, the entire set of

recordings will be looped. If start and end points have been set within the set of recordings, checking 

Loop Playback will initiate loopback between these two points.
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13.3.4.9. Skip Inactive Periods

Checking the Skip Inactive Periods box causes MediaWorks DX to skip inactive periods between

recordings when playing in Mixed mode. In Mixed mode, MediaWorks DX always proceeds in time

order and there may large gaps of silence separating recordings. By default, MediaWorks DX will skip

over any gaps and begin playing the next recording. Disabling this option will force MediaWorks DX to

play the inactive periods in real time.

13.3.4.10. AutoPlay After Cursor Move

On by default, this option controls whether scrubbing a paused call will automatically start playing. If

you want to move the playback position in the timeline while paused without having playback resume,

turn this off.

13.3.4.11. Time Marker Options

 

Fig. 13.9 Time Marker Options

This setting allows you to have MediaWorks DX beep or announce the time when specific events

happen during playback. You can choose to have the time announced in local time, or in UTC. The beep

or time can be heard at the start and/or, end of each call set, or every X number of seconds, or at the

start or end of each call. By default it will only say the time when annotations that have “Speak Talking

Time” configured are played back.
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13.3.4.12. Single Play

Checking the Single Play box stops playback in sequential mode after the data finishes playing for a

recording. If disabled, playback continues to play each recording, as listed in the record view, until the

end of the list is reached.

13.3.5. View Menu

 

Fig. 13.10 View Menu

Selecting View from the Menu Bar provides the following menu items:
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13.3.5.1. Theme

The Theme menu now gives you the options for Light, Dark, or Custom modes.

 

Fig. 13.11 Light Mode

In order to create a custom theme, select “view” dropdown, “Theme”, then “Configure…”.
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Fig. 13.12 Theme Configure

Here you’ll be able to adjust primary and secondary text and background colors.
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Fig. 13.13 Custom Theme

13.3.5.2. Multimedia Display Options

Multimedia recordings can be played back in the same way as Audio calls, but there are additional

options that relate to specifically to screens. These options are configured via the Multimedia Display

Options window, which is described in detail in Section 3.6: Playing Screen Recordings.

13.3.5.3. Enable Geo-Display

On a system with a Geolocation add-on license and location metadata, when enabled this will open the

Geo-Display popover window featuring a map and pin marks for call records that are tagged with

location data. For more details, see Section 8: Geolocation Features.
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13.3.5.4. Show Connections Icon

 

Fig. 13.14 Connections Icon

Checking the Show Connections Icon will display Connection Icon for fast access to the Connection

Information window.

13.3.5.5. Show Alarms Icon

When Show Alarms Icon is selected, the alarm icon (a triangle surrounding an exclamation mark) at the

right side of the menu bar will display. When the icon is grey, there are no active alarms.

 

Fig. 13.15 Alarm Icon (Nothing Active)

When the icon is red, there are unacknowledged active alarms.
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Fig. 13.16 Alarm Icon (Unacknowledged Alarm Active)

When the icon is yellow, there are active alarms, but they are all acknowledged.

 

Fig. 13.17 Alarm Icon (Alarms Active But Acknowledged)

In any case, if you click on the icon, it will open the Active Alarms page of Configuration Manager.

13.3.5.6. Show Reports Icon

Checking the Show Reports Icon will display Reports Icon for fast access to the View Reports window.

 

Fig. 13.18 Reports Icon
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13.3.5.7. Show Clear Filters Icon

Checking the Show Clear Filters Icon will display the Clear Filters Icon for fast access to the Clear

Search Filters option. This is useful if you make heavy use of the Search Filters feature.

 

Fig. 13.19 Clear Filters Icon

13.3.5.8. Connection Information

This will open the Connection Information pop up window. See above in Section 10.1: Connection

Information.

13.3.5.9. Alarms

This will open the Alarms page of Configuration Manager in a pop up window.

13.3.5.10. Reports

This will open the Completed Reports page of Configuration Manager in a pop up window.
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13.3.5.11. Archives

This will open the Archives page of Configuration Manager in a pop up window.

13.3.5.12. Play Audible Alarm

This will enable sound for active alarms. When an alarm is triggered on the recorder, the alarm sound

will play as 4 beeps, pause 15 seconds and repeat, until you go to Active Alarms page and acknowledge

the alarm.

13.3.5.13. Show Export Markers

Checking the Show Export Markers box will display boundary markers for Mixed Mode Exporting.

These red markers default to the start and end of any browse or searched results, and when set within

results will grey out the area that is not inside the boundaries.

13.3.5.14. Show Loop Markers

Checking the Show Loop Markers box will display the current loop points as blue markers in the

timeline header.

13.3.5.15. Show Calltype in Timeline

This will show Calltype icons in the timeline. See Section 13.2: Calltype for more information.

13.3.5.16. Show Tab Search

This will open the Tab Search pop up. See Section 2.6: Tab Search for more information.
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13.3.5.17. Follow Playback

Checking the Follow Playback box will cause the playback indicator to remain centered in the timeline

as the recording is playing.

13.3.5.18. Show Playing Record

This option will bring the currently playing record into view on the Call Grid. By default, the playing

record will stay in view, but if you use the scroll bar, this is overridden. Using this option will bring the

playing record into view and resume following it.

13.3.5.19. Column Defaults

Column Defaults will open a window to set the default columns for the call grid. Use the left & right

arrows to move fields into or out of the list, and the up and down ones to reorder them.

13.3.5.20. Save Current Columns Layout as Default

An alternative to Column Defaults is to set up your preferred columns in the current tab and use this

menu item to save them as the user default. This method has the added benefit of saving the current

column widths as well.

13.3.5.21. Warn On Exit

With Warn On Exit checked, MediaWorks DX will prompt for confirmation if you try to close the

window or navigate to a different web page.

13.3.6. Help Menu

Selecting Help from the Menu Bar provides the following menu items:
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Fig. 13.20 Help Menu

13.3.6.1. User Manual

Selecting User Manual from the Help menu will open a link to this user manual as a PDF file.

13.3.6.2. About…

Selecting About from the Help menu provides information about this release of MediaWorks DX.

 

Fig. 13.21 About Pop Up
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13.4. Translations

MediaWorks DX is supported in multiple languages via user-configurable translations. See NexLog DX-

Series manual for further information or contact your Eventide Rep for more details.

 

Fig. 13.22 MediaWorks DX Translations
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14. ADDITIONAL OPTIONAL FEATURES

MediaWorks DX has optional features that are off by default.

They are enabled via the Recorder settings on the front panel or via Configuration Manager, on the 

Users and Security: System Security page.

The features:

Incident Clip Management

User Content Uploads

Terms of Service Splash Screen

Media Access Blocking

Air Traffic Control / Air Traffic Management Mode

14.1. Incident Clip Management

Incident Clip Management allows users making incidents to join or split audio calls in an incident so that

the calls are played back correctly. The original call records remain on the recorder in their as-recorded

state.

More details and usage information can be found in Section 4.7: Incident Clip Management.

14.2. User Content Uploads

User Content Uploads allows a user to upload media to a NexLog DX-Series recorder channel, and use

that media for incidents, evaluations, or general playback.

See Section 12: User Content Uploads

14.3. Terms of Service Splash Screen

A custom Terms of Service splash screen can be show at login time for all users by checking the Enable

Terms of Service splash screen in MedaWorks Plus clients (edit contents in System → Configuration →

Terms of Service) box on this page. To configure the text for this, navigate to System Settings:

Configuration Files and edit the file named Terms of Service.

• 

• 

• 

• 

• 
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Fig. 14.1 Example Terms of Service

14.4. Media Access Blocking

If a call or screen containing sensitive information is recorded, a site may want to limit who can listen to

or view it. Block Media Access is an optional feature that allows supervisors to restrict the playback of

individual recorded media to certain users only. The call record and it’s metadata (notes, time, duration,

etc) will still be visible for all users, but only specified users will be able to play it.

When enabled, any user with the Client Software: Block_Access_To_Recordings Permissions  can

right-click a call record or group of call records and select Block Media Access. This will pop up the

window shown below:

 

Fig. 14.2 Block Media Access Pop Up Window
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In this dialog box you can block access to this media by checking the box next to Block Media Access.

The Exceptions area grants permission to listen to this call to the checked users and user groups. When

blocking access, the logged in user is automatically checked for access.

The status bar at the top can show a variety of messages, based on the state of the call(s) selected when

opening the window. If all calls have the same state, it will say Access is not blocked or “Access blocked by

(user name) at (date & time); if all of the records are blocked but the times or exceptions are different it

will say Records are blocked in this dataset with varying exceptions and/or dates:

 

Fig. 14.3 Example Block Media Access Status Messages

If multiple call records with different states are selected and Block Media Access is opened, settings

that differ across the calls will be shown with a – in the check box. If left unchanged, these settings will

not be changed when OK is clicked. To apply that setting to all calls, click once to check the box. To

remove the setting from all selected calls, click twice to empty the box.

14.5. Air Traffic Control / Air Traffic Management Mode

Air Traffic Control / Air Traffic Management mode swaps out Incidents for Impounds & Quarantines.

These are covered in depth in Appendix A: Air Traffic Control/Management Mode.
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14.6. Interleaved Mode

MediaWorks DX now offers the ability to differentiate between multiple streams on a VoIP recorder and

visualize multiple voicings on the Timeline View.

 

Fig. 14.4 Interleaved Call Mode

The Example above shows two streams of dialog on one channel, with each voice represented by

different shades of color.

 Note

Interleaved Call Mode requires an additional VoIP add-on service. See your Eventide Rep for more

information.

Interleaved Mode Configuration
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In order to enable Interleaved Call Mode, a user must refer to their NexLog DX-Series configurations ->

Recording -> Recording Interfaces, and update their IP Recording’s Encoding settings to “Mulaw

Seperate Streams” which can be found in settings section -> Audio Storage Encoding.

 

Fig. 14.5 VoIP Encoding Settings

 

Fig. 14.6 VoIP Interface

14. ADDITIONAL OPTIONAL FEATURES 153



The VoIP Channels that were updated will now show multiple streams of communication on the

specified channels in MediaWorks DX.
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15. MEDIAWORKS DX DESKTOP

MediaWorks DX Desktop is a new standalone application that allows the use of MediaWorks DX

without requiring regular internet browser access. System administrators can download the

MediaWorks DX Desktop installer from the NexLog Recorder and install it for use by call takers and

researchers who do not have web browser privileges.

15.1. Installing MediaWorks DX Desktop

The download link for MediaWorks DX Desktop is on the recorder’s Downloads page. This page is

found here:

https://<hostname of recorder>/webconfig.fcgi?section=dl

Your browser may complain that this is a rarely downloaded file. Click the menu on the side to say keep.

When you launch the installer, you may receive a notification from Microsoft Windows alerting you that

Administrative permissions are required. If you are authorized to install applications on your PC, then

click Run.

 

Fig. 15.1 Installer
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The installer will run and put shortcuts to the MediaWorks DX Desktop executable on the desktop and

in the Start menu.

 

Fig. 15.2 MediaWorks DX Desktop Install Complete

15.2. Using MediaWorks DX Desktop

MediaWorks DX Desktop functions identically to MediaWorks DX in most ways. The main difference is

how you connect to a NexLog recorder. MediaWorks DX connects directly to the recorder, because it is

a web page running in a browser pointed at the recorder.

MediaWorks DX Desktop needs to be told where the recorder is.
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Fig. 15.3 MediaWorks DX Desktop Login Prompt

When you launch MediaWorks DX Desktop for the first time, you will be greeted by a Login prompt.

This window allows you to log in by providing the Recorder IP address or domain name as well as the

User name and Password. You can save these values using the Save button and then later Load any

saved credentials from the list on the left.

You can also choose to use any of the three options:

Use Domain Single Sign On; If your recorder is configured with Enhanced Active Directory and

Single Sign On is enabled, select this option to log in as the currently logged in Windows User.

Note that the Recorder field must be a Fully Qualified Domain Name (e.g.

ExampleRecorder.ExamplePlace.Local) not an IP address for Single Sign On to work.

Use SSL: This will connect to the recorder using https:// rather than http://

Auto Login on Startup: In the case that you always want to log in to the same recorder, you can

select this and save the session. Then in the future when launching MediaWorks DX Desktop, it

will automatically log in to this recorder with these credentials. You can, of course, then logout

and log in to a different recorder at any time.

15.3. Reading Local Incidents with MediaWorks DX Desktop

MediaWorks DX Desktop can now load local incident files (.eti) without a connection to a NexLog

Recorder. Incidents loaded this way are Read Only. In order to open an .eti file without needing to

connect to a recorder, choose the Local Incident tab at the login prompt:

• 

• 

• 
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Fig. 15.4 MediaWorks DX Desktop Login Prompt Local Incident Tab

You can click the Choose File button to use a file browser to find the incident you want to open, or you

can drag and drop the .eti file into the tab. Then click OK. The incident will be verified and opened in

read-only; no changes can be made, but audio can be played back and exported, notes and attachments

can be viewed, etc., as expected when viewing a read-only incident in MediaWorks DX.
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16. MEDIAAGENT

MediaAgent is a new standalone application that allows the use of MediaAgent without requiring

regular internet browser access. System administrators can download the MediaAgent installer from the

NexLog Recorder and install it for use by call takers and researchers who do not have web browser

privileges.

16.1. Installing MediaAgent

The download link for MediaAgent is on the recorder’s Downloads page. This page is found here:

https://<hostname of recorder>/webconfig.fcgi?section=dl

Your browser may complain that this is a rarely downloaded file. Click the menu on the side to say keep.

When you launch the installer, you may receive a notification from Microsoft Windows alerting you that

Administrative permissions are required. If you are authorized to install applications on your PC, then

click Run.

 

Fig. 16.1 MediaAgent Installer
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The installer will run and put shortcuts to the MediaAgent executable on the desktop and in the Start

menu.

 

Fig. 16.2 MediaAgent Install Complete

16.2. Using MediaAgent

MediaAgent functions identically to the Instant Recall mode of MediaWorks DX in most ways. The main

difference is how you connect to a NexLog recorder. MediaWorks DX connects directly to the recorder,

because it is a web page running in a browser pointed at the recorder.
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MediaAgent needs to be told where the recorder is. When you launch MediaAgent for the first time,

you will be greeted by a Login prompt. This window allows you to log in by providing the Recorder IP

address or domain name as well as the User name and Password. You can save these values using the

Save button and then later Load any saved credentials from the list on the left.

You can also choose to use any of the three options:

Use Domain Single Sign On; If your recorder is configured with Enhanced Active Directory and

Single Sign On is enabled, select this option to log in as the currently logged in Windows User.

Note that the Recorder field must be a Fully Qualified Domain Name (e.g.

ExampleRecorder.ExamplePlace.Local) not an IP address for Single Sign On to work.

Use SSL: This will connect to the recorder using https:// rather than http://.

Auto Login on Startup: In the case that you always want to log in to the same recorder, you can

select this and save the session. Then in the future when launching MediaAgent, it will

automatically log in to this recorder with these credentials. You can, of course, then logout and log

in to a different recorder at any time.

• 

• 

• 
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17. MEDIAWORKS DX URL ARGUMENTS

17.1. URL Arguments

The base URL for MediaWorks DX is:

https://<hostname of recorder>/client/mediaworks/

URL arguments are added after the forward slash of the base URL. The first argument must be

prepended with a question mark, and each subsequent argument must be prepended with an

ampersand (&).

Example: https://demo.nexlogdx.com/client/mediaworks/?arg1=value1&arg2=value2

17.1.1. Chrome Application

Enables a Chrome Application Instant Recall interface where sessionType=1 and tabType=5

Argument: chromeApp

Values: [integer]

1 - Enable

 

Fig. 17.1 Enables a Chrome Application Instant Recall interface where sessionType=1 and

tabType=5
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17.1.2. Debugging

Displays a popup for each window.onerror event that occurs.

NOTE: This is for debugging purposes only.

Argument: alertErrors

Values: [integer]

1 - Enable

17.1.3. Define Columns

Restricts client interface to specific columns and column width.

“Width” is an optional attribute that can be used to assume a certain percentage of the total space. If

you don’t set any widths, each column will attempt to use an equal portion. It’s not recommended to set

some columns with widths, while leaving others unset.

Argument: defineColumns

Value: [string]

defineColumns ={“name”:ColumnName, “width”:10}

17.1.4. Descriptor

Specifies the source location of the ETI file to be loaded. Should be paired with eti to open the source
file. The value should be the incident record’s GUID.

Argument: descriptor

Values:[string]

string - ETI source file location
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17.1.5. Disable IR Filters

Removes the filter options from the Instant Recall interface. Should be paired with setFilter so that the

tab knows what it should display

Argument: hideFilterOptions

Values:[integer]

1 - Enable, hides filters

17.1.6. Disable Record Context Menu

Disables call record right click menu.

Argument: disableContextMenu

Values: [integer]

1 – Enable, disables record right click menu

17.1.7. ETI

Enables the automatic loading of a packaged incident file (ETI). Should be paired with descriptor

Argument: eti

Values:[integer]

1 - Enable

17.1.8. Evaluation

Opens a specific Quality Factor evaluation. The value should be the evaluation record’s GUID.

Argument: evaluationGuid
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Values:[string]

string - Evaluation GUID to open

17.1.9. Headless

Hides File menu from callgrid header. Useful for small windows. Should be paired with IR tab and

hideFilterOptions arg.

Argument: headless

Value: [integer]

1 – Enable, shows IR without header

17.1.10. Hide Transport

Hides main audio player controls. For audio playback, this should be paired with miniTransport

Argument: hideTransport

Values:[integer]

1 - Enable, hides main transport
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Fig. 17.2 Hidden Transport

17.1.11. Incident

Opens a specific incident. The value should be the incident record’s GUID.

Argument: incidentGuid

Values:[string]

string - Incident GUID to open

17.1.12. Instant Recall Minutes

Sets the minutes in the lookback period for Instant Recall.

Argument: instantRecallMinutes

Values:[integer]

0-480 - Number of minutes
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17.1.13. Miniature Transport

Forces the miniature transport interface to be used for audio playback.

If the standard transport should be hidden, pair this argument with hideTransport

Argument: miniTransport

Values:[integer]

0 - Disables, use standard transport

 

Fig. 17.3 Standard Transport

1 - Enabled, use Mini Transport

 

Fig. 17.4 Mini Transport

17.1.14. Mobile Interface

Forces the mobile interface to be used.

Argument: forceMobile

Values:[integer]

1 - Enable, forces mobile interface and license to be used
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Fig. 17.5 Mobile Interface

17.1.15. Password

Sets the application password, must be paired with username for automatic login.

WARNING: The password will be clearly visible in the URL field

Argument: password

Values:[string]

string - Sets the application username

17.1.16. Session Type

Restricts client interface to a specific view element.

Should be paired with tabType

Argument: sessionType

Values:[integer]

1 - Full View
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Fig. 17.6 Full View

2 - Call Grid Only

 

Fig. 17.7 Call Grid Only

3 - Timeline Only

 

Fig. 17.8 Timeline Only
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17.1.17. Set Filter

Sets the filter used for Instant Recall results. Values are entered as an array. The string must be URL

encoded. Multiple filters can be joined with a comma ,.

Argument: setFilter

Values:[filter:string]

user_id:string - Also accepts CURUSER to filter for the logged in user.

channelname:string - Filters on Channel Name

∗resourcegroup∗:string - Filters on Resource Group

custom_field:string - Filters on the system’s custom fields, using the specified string.

17.1.18. Shortcut Keys

Enables/Disables keyboard shortcuts using Ctrl, Shift, or Alt.

Argument: ignoreKeys

Values:[integer]

1 - Enable, disables shortcut keys

17.1.19. Show Map

Displays the map in full view for instant recall. Should be paired with sessionType=1, and setFilter for

best usage.

Argument: map

Values:[string]

full - Enable, shows maximized map of media
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Fig. 17.9 Map

17.1.20. Tab Type

Restricts client interface to a specific tab. Should be paired with sessionType

Argument: tabType

Values:[integer]

0 – Channels

1 – Search

2 – Browse

3 – Evaluation

4 – Incident

5 - Instant Recall

17.1.21. Touch Mode

Allows to use MWP on touchscreen desktops.

Argument: touchMode
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Value: [integer]

1 – Enable, allows to use MWP on touch screen desktop.

17.1.22. Username

Sets the application username, must be paired with password for automatic login.

Argument: username

Values:[string]

string: Sets the application username
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18. REPORTING PROBLEMS

It is Eventide’s policy to work directly with dealers. Your dealer must report your problem to Eventide

with the following information in order to process the service/support request:

Serial number(s) of the affected recorder(s).

Software versions for the recorder(s).

Severity of the issue, including a detailed description.

Contact information (phone and email) for the dealer and on-site technician.

To contact Eventide customer service for support, call 201-641-1200 Option 6 followed by Option 2

(Communications/Recorders Division) or email service@eventide.com.

• 

• 

• 

• 
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A. AIR TRAFFIC CONTROL/MANAGEMENT
MODE

 License Required

This feature must be licensed to be used. Contact your Eventide Dealer for assistance.

 Disabled by Default

This feature must be manually enabled. See the NexLog DX-Series User Manual or Contact your

Eventide Dealer for assistance.

ATC/ATM mode makes changes to MediaWorks DX to suit the needs of Air Traffic Control and Air

Traffic Management sites:

Incidents are renamed Impounds

Archive drives can be designated a Quarantine Storage Location and impounds can be saved to

them as a Quarantine. A quarantine can be thought of as a hybrid archive-incident.

The search tab features a Create Impound button that will create a new impound containing the

search results, and add the search used to the impound History.

Advanced Impound Audit History

A.1. Setting Up ATC/ATM mode

ATC/ATM mode requires an Add-On license. Once licensed, to enable ATC mode, go to the Users and

Security: System Security page in Configuration Manager, check the Enable MediaWorks Plus ATC/ATM

mode check box, and click save.

Once ATC is enabled, MediaWorks DX will now have a new login screen at load time, as seen in Fig. A.1

• 

• 

• 

• 
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Fig. A.1 ATC/ATM Login Screen

A.2. Impounds

Just like incidents in non-ATC mode MediaWorks DX, an impound is a collection of related recordings

with associated notes and attachments. Impounds can be saved directly on the recorder, or into

Quarantine Storage, which makes a separate copy of the media on a configured archive location.

Quarantines require an additional license and are covered further in Section A.3.

All features and options of incidents are available for impounds as well.

A.2.1. Creating an Impound

Records can be added to an Impound just as they are to Incidents, as detailed in Section 4: Creating an

Incident.
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A.2.2. Creating an Impound From Search

 

Fig. A.2 Create Impound Button on Search Tab in ATC/ATM Mode

Impounds can also be directly created from the search tab with the Create Impound button. This button

will create an impound containing all the records in the current search results and include the exact

search terms in the audit history of this impound.

For example, if site policy requires that all records from a day should be impounded when an event of

interest occurs, one can perform a search for all resources, on that calendar day, and then click the 

Create Impound button, which will open a new impound and add the search used to create the impound

to its audit history.

 

Fig. A.3 Impound History with Search Terms Shown in Mouse-Over Pop Up
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A.2.3. Saving Impounds

 

Fig. A.4 Save Impound/Quarantine As

Impounds can be stored directly on the recorder, and optionally also saved to a Quarantine storage

location, with a separate copy of the impound and all record media is saved to the quarantine storage

location directly as separate copy.

A.2.3.1. Saving an Impound on the Recorder

To save an impound remotely on the recorder, first make sure the Impound tab is selected, then select

Save Impound/Quarantine from the File menu. If this is a new impound, when the Save Impound dialog

box appears, the Recorder tab will be automatically selected.

If checked, the Protect Recordings from Deletion option will automatically mark all recordings as

protected when saving the impound; this is on by default. When saving an impound with many calls

with this option enabled, a progress bar will pop up to provide feedback while the system is protecting

calls. The impound properties and permissions can be edited here as well, just like incidents.

The Description field can be used to make it easier to find the impound again later, by including

information about what the impound contains.

The Password fields can be used to password protect the impound. If used, only people who know the

password will be able to open the impound, regardless of the impound’s read/write property settings.
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Enter an Impound Name and then click OK to save.

A.2.3.2. Saving an Impound to a Quarantine

Check the box for Save Media to Quarantine Location to save a full copy of this impound and its

associated media and attachments to the default Quarantine Storage Location. If this has not been set,

the user will be prompted to select one before the impound can be saved.

Quarantines can only be saved if a Quarantine Storage Location has been configured in the Archive

Configuration page of Configuration Manager (covered in Quarantine Storage Locations) and

Quarantine Storage add-on license is present.

A.2.3.3. Downloading an Impound

Impounds can be also be downloaded to your computer. To download, you must first save the impound

to the recorder. Once it is saved, select Save Impound/Quarantine As… from the File menu, and choose

the Download tab. You can optionally enter a password here that the impound will require to open.

This file can then be shared and opened with the Open Impound/Quarantine file menu option, by

clicking the local tab and clicking Add File. Select an .eti file, click ok and then click OK in the Open

Impound/Quarantine dialog. If there is a password, you will be prompted to enter it and if that

succeeds, the impound will open with all the calls, notes, attachments and metadata as seen on the

original recorder.

A.2.3.4. Renaming an Impound

Impounds can be renamed by right-clicking on the impound either in the open impound menu or on the

tab of an open impound.

 

Fig. A.5 Rename Option in Tab Right-Click Menu

A. AIR TRAFFIC CONTROL/MANAGEMENT MODE 181



 

Fig. A.6 Rename Pop Up

A.2.3.5. Impound Properties

 

Fig. A.7 Impound Properties

The Properties button (at the top of the tab and in the Save window) opens to an Impound Properties

window that allows for a searchable text description of the impound, as well as fine control of which

permissions each user on the system has for this impound. This acts the same as the Incident Properties

window covered in Section 13.3.2.3 of this document.

Unique to Impounds & Quarantines, there is a History tab that shows a log of events, such as Impound

Created, Media Added, Media Removed, Impound Saved, etc, with associated information such as the

Media time and CallGUID, the event time, and the user that made the change. If an impound was

created directly from search results with the Create Impound button, an entry will exist with the

description “Impound created with search results: (description of search result)”.

Mouse over each line to see a pop up containing the full text of the field, as shown in Fig. A.3.
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A.3. Quarantines

A quarantine is an impound that has been saved to secure location, separate from the Recorder’s drives,

to meet the needs of ATC data policies. A Quarantine is conceptually like a combination of an Archive

and an Incident, in effect an Archived-Incident. Archive drives on the recorder, usually Network

Attached Storage or RDX, can be set to be Quarantine Storage Locations, and Impounds can be saved

to them as a read-only Quarantine, copying all media records from the recorder to the separate storage

location.

Use of Quarantines requires an add-on license for the number of drives that can simultaneously be

configured as a Quarantine Storage Location.

A.3.1. Quarantine Storage Locations

A Quarantine Storage Location is a secure location to save an impound as a Quarantine, separate from

the Recorder. Archive drives on the recorder, usually Network Attached Storage or RDX, can be set to

be Quarantine Storage Locations, and Impounds can be saved to them, copying all media records from

the recorder to the separate storage location. Multiple Impounds can be saved to the same Quarantine

Storage Location. To select where to save Quarantines, click the Configure… button in the Save

Impound/Quarantine dialog box. This will pop up a window, as shown below, that will list all configured

Quarantine Storage Locations. Select a drive from this list and click ok.

 

Fig. A.8 Quarantine Location Configuration
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A.3.1.1. Configuring a Drive as a Quarantine Storage Location

Once the recorder is licensed, go to the Archives: Archive Configuration page of Configuration Manager

and select a drive. Click Configure, and then enable Use as Quarantine.

 

Fig. A.9 Archive Configuration
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